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 2
I n t r o d u c t i o n
This guide describes the Mixer Module, an optional add-on package for 
COMSOL Multiphysics® designed to assist you in setting up and solving transport 
problems in mixers and stirred vessels. The module is an add-on to the CFD 
Module and provides additional support for modeling fluid flow in rotating 
machinery.

This chapter introduces you to the capabilities of the module. A summary of the 
physics interfaces and information about where to find documentation and model 
examples is also included. This is followed by a brief overview with links to each 
chapter in the guide. The last section in this introduction contains a tutorial 
example from the Mixer Module application library.

This chapter contains the following sections:

• About the Mixer Module

• Overview of the User’s Guide

• Tutorial Example — Nonisothermal Mixer
 7
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Abou t  t h e  M i x e r  Modu l e

The development of new products and processing lines continuously places high 
demands on mixer design. The Mixer Module provides engineers and scientists with 
the necessary simulation tools for predicting and understanding the interactions 
between fluid flow and chemical processes in mixers and stirred vessels. The detailed 
information gained from computational fluid dynamics (CFD) simulations 
substantially reduces the number of empirical studies needed in new product and 
process designs, and has eminent impact on both costs and responses to environmental 
considerations.

Figure 2-1: Streamlines and velocity magnitude in a cross section of a dished bottom 
baffled mixer with a four-bladed impeller. The color scale on the baffles represents the 
pressure.

The Mixer Module complements the CFD Module with additional functionality for 
the Rotating Machinery, Fluid Flow branch. The added functionality includes 
extended capability for modeling turbulence in the Rotating Machinery interfaces.

In order to facilitate fast and efficient setup of mixer geometries, the Mixer Module 
Part Library includes predefined geometry components typical of mixer equipment. 
2 :  I N T R O D U C T I O N



The part library includes impeller parts for axial impellers, radial impellers, and 
impellers designed for highly viscous fluids. In addition to impellers, three types of 
different tank geometries and a cylindrical impeller shaft geometry are available in the 
part library. All mixer parts are modularized through a number of input parameters 
corresponding to important geometrical properties of each part. These can be adjusted 
in order to fit the mixer system under investigation.

A high rotation rate or a strong acceleration of the rotation rate may induce a 
substantial deformation of the free surface in an open vessel. This topology change in 
turn influences the flow pattern inside the vessel. The Mixer Module includes 
free-surface features to capture the displacement of the liquid-air interface induced by 
the bulk motion in the domain, by the walls, and by the rotating shaft.

The physics interfaces define a fluid-flow problem using physical quantities such as 
pressure, flow rate, temperature, and species composition, as well as physical 
properties, such as viscosity, thermal diffusivity, and density. The different physics 
interfaces cover a wide range of laminar and turbulent mixer flows. The conservation 
laws formulated by the physics interfaces are expressed in terms of partial differential 
equations along with corresponding initial and boundary conditions. The equations 
are solved by the module using stabilized finite element formulations for fluid flow in 
combination with damped Newton methods and, for time-dependent problems, in 
combination with various time-dependent solver algorithms. The Mixer Module’s 
general capabilities include frozen-rotor and time-dependent flows in two- and 
three-dimensional spaces. For a so-called frozen-rotor flow, the topology relative to 
the rotating reference frame is fixed (“frozen”). When the flow field is, or can be 
approximated to be, of this type the computational time (CPU time) can be 
substantially reduced using the Frozen Rotor (see the CFD Module User’s Guide) 
study type.

The workflow in the Mixer Module is quite straightforward. Set up a simulation using 
one of the Rotating Machinery interfaces, described by the following steps: define the 
geometry, select the fluid to be modeled, select the type of flow, define boundary and 
initial conditions, define the finite element mesh, select a solver, compute the solution, 
and visualize the results. All these steps are performed from the COMSOL Desktop. 
The mesh and solver steps are usually carried out automatically using default settings, 
which are tuned specifically for each Fluid Flow interface.

The models available in the Mixer Module application library describe the physics 
interfaces and their features through examples for different types of mixer flows. Here 
you find examples of industrial equipment and devices, tutorial models for practice, 
A B O U T  T H E  M I X E R  M O D U L E  |  9
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and benchmark models for verification and validation of the Fluid Flow interfaces. Go 
to The Application Libraries Window to access these resources.

To help you get started, this introduction contains a list of the physics interfaces and 
an example, Tutorial Example — Nonisothermal Mixer, to introduce you to the 
workflow.

A S P E C T S  O F  M I X E R  S I M U L A T I O N S

In the initial stages of development for a product, or a new process line, the focus 
usually lies on qualitative results such as determining whether or not the flow is well 
mixed, whether a heated reactor is free from hotspots, or whether the flow field 
contains recirculation zones, which can be inaccessible to reactants. Qualitative results 
such as these are usually the first step toward creating or improving a design. During 
the later stages of development, the focus shifts toward scale-up and optimization. For 
mixing of pseudoplastic slurries, for example, the yield stress has to be overcome 
everywhere. Bioreactors, on the other hand, should not contain regions of excessive 
shear. Obtaining accurate estimates for the yield stress, shear or other process 
parameters such as reaction rates, thermal equilibration times, torque, and energy 
consumption, provides developers with the edge needed to assume a competitive 
position within their field.

The choice of which physics to include in your simulations can be based on 
experimental results, experience, or a dimensional analysis. Excluding relevant physics 
undoubtedly leads to wrong results, while including “everything” leads to excessive 
computational time. The Rotating Machinery interfaces help you set up problems of 
varying complexity. If the mixed quantity is passive, you can use one of the Rotating 
Machinery, Fluid Flow interfaces to solve for the fluid flow, and then add a Transport 
of Diluted Species interface to determine other properties, for example, the mixing 
efficiency. Both reactions and thermal variations affect constitutive quantities, such as 
the density and viscosity of the fluid. When these effects become appreciable, you can 
switch to the Rotating Machinery, Reacting Flow interfaces or the Rotating 
Machinery, Nonisothermal Flow interfaces. When the mixed quantity consists of 
particles droplets or bubbles, possibly with a different density and response time 
compared to the surrounding fluid, you can switch to the Rotating Machinery, 
Multiphase Flow interfaces. Taking it one step further, COMSOL Multiphysics lets 
you add other physics interfaces to preexisting ones to tailor simulations to your 
application.
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The physics interfaces in the Mixer Module are able to perform all steps in mixer 
analyses, from the initial idea and qualitative simulations to the final optimization of 
the product or process.

The Mixer Module Physics Interface Guide

The Rotating Machinery interfaces in this module are based on the laws for 
conservation of momentum, mass, and energy in fluids. The different physics 
interfaces contain different combinations and expressions of the conservation laws, 
which apply to the physics of the flow field being modeled. Figure 2-2 shows the 
Rotating Machinery interfaces as they are displayed when you add a physics interface 
(see Physics Interface Guide by Space Dimension and Study Type). A short description 
of the various types of physics interfaces follows.

Figure 2-2: The Rotating Machinery interfaces for laminar and turbulent flow.
A B O U T  T H E  M I X E R  M O D U L E  |  11



12 |  C H A P T E R
R O T A T I N G  M A C H I N E R Y ,  F L U I D  F L O W

The Rotating Machinery, Laminar Flow interface ( ) is used primarily for modeling 
flows of low to intermediate Reynolds numbers. This physics interface solves the 
Navier-Stokes equations for incompressible (default), weakly compressible and 
compressible flow (up to Mach 0.3). The physics interface is also capable of simulating 
non-Newtonian fluid flow.

The Rotating Machinery, Turbulent Flow interfaces ( ) are used to model flow at high 
Reynolds numbers. These physics interfaces solve the Reynolds-averaged 
Navier-Stokes (RANS) equations for the averaged velocity field and averaged pressure. 
The different physics interfaces in this branch have different models for the turbulent 
viscosity. There are several turbulence models available — two algebraic turbulence 
models, the Algebraic yPlus and L-VEL models, and seven transport-equation models, 
including a standard k-ε model, the Realizable k-ε model, a k-ω model, a SST model, 
a low Reynolds number k-ε model, the Spalart-Allmaras model, and the v2-f model. 
Similarly to the Rotating Machinery, Laminar Flow interface, compressibility is set to 
incompressible by default.

The Algebraic yPlus and L-VEL turbulence models are so-called enhanced viscosity 
models. A turbulent viscosity is computed from the local distance to the nearest wall. 
For this reason, the algebraic turbulence models are best suited for internal flows, such 
as in electronic cooling applications. Algebraic turbulence models are computationally 
economical, and more robust but, in general, less accurate than transport-equation 
models. Among the transport-equation turbulence models, the standard k-ε model is 
the most widely used turbulence model because it is often a good compromise between 
accuracy and computational cost (memory and CPU time). The Realizable k-ε model 
is similar to the standard k-e model but has built-in realizability constraints, resulting 
in improved performance for certain flows, such as turbulent jets. The k-ω model is an 
alternative to the standard k-ε model and often gives more accurate results, especially 
in recirculation regions and close to solid walls. However, the k-ω model is also less 
robust than the standard k-ε model. The SST model combines the robustness of the 
k-ε model with the accuracy of the k-ω model, making it applicable to a wide variety 
of turbulent flows. The low Reynolds number k-ε model is more accurate than the 
standard k-ε model, especially close to walls, but requires higher resolution in the 
near-wall region. The Spalart-Allmaras model is specifically designed for aerodynamic 
applications, such as flow around wing profiles, but is also widely used in other 
applications due to its high robustness and decent accuracy. In the v2-f model, the 
turbulent viscosity is based on the wall-normal velocity fluctuations, whereby wall 
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blockage effects and low Reynolds number effects are captured separately. The v2-f 
model also includes non-local effects of the fluctuating pressure on the turbulent fields.

R O T A T I N G  M A C H I N E R Y ,  M U L T I P H A S E  F L O W

The Rotating Machinery, Mixture Model interfaces ( ) combine the functionality of the 
Rotating Machinery, Fluid Flow and Mixture Model interfaces. The interfaces are 
designed to study the flow of a two-phase mixture, consisting of a continuous phase 
and a dispersed phase, in rotating and stationary domains. Both phases are assumed to 
be incompressible. The dispersed phase can be bubbles, liquid droplets, or solid 
particles, which are assumed to always travel with their terminal velocity through the 
continuous phase. Physics interfaces for both laminar flow and turbulent flow are 
available. For turbulent flow the Reynolds-averaged Navier-Stokes (RANS) version of 
the mixture model equations are solved, and all the turbulent models available for the 
Rotating Machinery, Fluid Flow interfaces are also available.

R O T A T I N G  M A C H I N E R Y ,  N O N I S O T H E R M A L  F L O W

The Rotating Machinery, Nonisothermal Flow, Laminar Flow interface ( ) is used 
primarily to model laminar flow where the temperature and flow fields have to be 
coupled, such as in an externally heated mixer. This multiphysics interface has 
predefined functionality for coupling heat transfer in fluids and solids. The weakly 
compressible option is selected by default for the Rotating Machinery Nonisothermal 
flow interfaces.

The Rotating Machinery, Nonisothermal Flow, Turbulent Flow interfaces ( ) solve the 
Reynolds-averaged Navier-Stokes (RANS) equations together with the equations for 
heat transfer in fluids and in solids. There is support for all the fluid-flow turbulence 
models - the Algebraic yPlus model, the L-VEL model, the standard k-ε model, the 
Realizable k-ε model, the k-ω model, the SST model, a low Reynolds number k-ε 
model, the Spalart-Allmaras model, and the v2-f model.

R O T A T I N G  M A C H I N E R Y ,  R E A C T I N G  F L O W

The Rotating Machinery, Reacting Flow interfaces ( ) combine the functionality of the 
Rotating Machinery, Fluid Flow and Transport of Concentrated Species interfaces. 
The mass and momentum transport in a rotating reacting fluid can be modeled from 
a single physics interface, and the couplings between the velocity field and mixture 
density are set up automatically. Physics interfaces for both laminar flow and turbulent 
flow using the Reynolds-averaged Navier-Stokes (RANS) equations are available. 
There is support for the following turbulence models - the standard k-ε model, the k-ω 
model, the SST model, and the low Reynolds number k-ε model.
A B O U T  T H E  M I X E R  M O D U L E  |  13
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P H Y S I C S  I N T E R F A C E  G U I D E  B Y  S P A C E  D I M E N S I O N  A N D  S T U D Y  T Y P E

The list below shows the Rotating Machinery interfaces available with the Mixer 
Module. Because the Mixer Module requires a license for CFD, additional physics 
interfaces are listed in the CFD Module User’s Guide.

PHYSICS INTERFACE ICON TAG SPACE 
DIMENSION

AVAILABLE STUDY TYPE

 Chemical Species Transport

 Rotating Machinery, Reacting Flow

Laminar Flow — 3D, 2D, frozen rotor; time 
dependent

 Turbulent Flow

Turbulent Flow, k-ε — 3D, 2D frozen rotor; time 
dependent

Turbulent Flow, k-ω — 3D, 2D frozen rotor; time 
dependent

Turbulent Flow, SST — 3D, 2D frozen rotor with 
initialization; time 
dependent with 
initialization

Turbulent Flow, Low 
Re k-ε

— 3D, 2D frozen rotor with 
initialization; time 
dependent with 
initialization

 Fluid Flow

 Single-Phase Flow

 Rotating Machinery, Fluid Flow

Rotating Machinery, 
Laminar Flow

spf 3D, 2D frozen rotor; time 
dependent
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Rotating Machinery, 
Turbulent Flow, 
Algebraic yPlus

spf 3D, 2D frozen rotor with 
initialization; time 
dependent with 
initialization

Rotating Machinery, 
Turbulent Flow, L-VEL

spf 3D, 2D frozen rotor with 
initialization; time 
dependent with 
initialization

Rotating Machinery, 
Turbulent Flow, k-ε

spf 3D, 2D frozen rotor; time 
dependent

Rotating Machinery, 
Turbulent Flow, 
Realizable k-ε

spf 3D, 2D frozen rotor; time 
dependent

Rotating Machinery, 
Turbulent Flow, k-ω

spf 3D, 2D frozen rotor; time 
dependent

Rotating Machinery, 
Turbulent Flow, SST

spf 3D, 2D frozen rotor with 
initialization; time 
dependent with 
initialization

Rotating Machinery, 
Turbulent Flow, Low 
Re k-ε

spf 3D, 2D frozen rotor with 
initialization; time 
dependent with 
initialization

Rotating Machinery, 
Turbulent Flow, 
Spalart-Allmaras

spf 3D, 2D frozen rotor with 
initialization; time 
dependent with 
initialization

Rotating Machinery, 
Turbulent Flow, v2-f

spf 3D, 2D frozen rotor with 
initialization; time 
dependent with 
initialization

  Rotating Machinery, Multiphase Flow

Mixture Model, 
Laminar Flow

mm 3D, 2D frozen rotor, time 
dependent

PHYSICS INTERFACE ICON TAG SPACE 
DIMENSION

AVAILABLE STUDY TYPE
A B O U T  T H E  M I X E R  M O D U L E  |  15
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Mixture Model, 
Algebraic yPlus

mm 3D, 2D frozen rotor with 
initialization; time 
dependent with 
initialization

Mixture Model, L-VEL mm 3D, 2D frozen rotor with 
initialization; time 
dependent with 
initialization

Mixture Model, k-ε mm 3D, 2D frozen rotor, time 
dependent

Mixture Model, 
Realizable k-ε

mm 3D, 2D frozen rotor, time 
dependent

Mixture Model, k-ω mm 3D, 2D frozen rotor, time 
dependent

Mixture Model, SST mm 3D, 2D frozen rotor with 
initialization; time 
dependent with 
initialization

Mixture Model, Low 
Re k-ε

mm 3D, 2D frozen rotor with 
initialization; time 
dependent with 
initialization

Mixture Model, 
Spalart-Allmaras

mm 3D, 2D frozen rotor with 
initialization; time 
dependent with 
initialization

Mixture Model, v2-f mm 3D, 2D frozen rotor with 
initialization; time 
dependent with 
initialization

 Nonisothermal Flow

 Rotating Machinery, Nonisothermal Flow

Laminar Flow — 3D, 2D frozen rotor; time 
dependent

PHYSICS INTERFACE ICON TAG SPACE 
DIMENSION

AVAILABLE STUDY TYPE
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Where Do I Access the Documentation?

A number of internet resources have more information about COMSOL, including 
licensing and technical information. The electronic documentation, topic-based (or 

Turbulent Flow, 
Algebraic yPlus

— 3D, 2D frozen rotor with 
initialization; time 
dependent with 
initialization

Turbulent Flow, L-VEL — 3D, 2D frozen rotor with 
initialization; time 
dependent with 
initialization

Turbulent Flow, k-ε — 3D, 2D frozen rotor; time 
dependent

Turbulent Flow, 
Realizable k-ε

— 3D, 2D frozen rotor; time 
dependent

Turbulent Flow, k-ω — 3D, 2D frozen rotor; time 
dependent

Turbulent Flow, SST — 3D, 2D frozen rotor with 
initialization; time 
dependent with 
initialization

Turbulent Flow, Low 
Re k-ε

— 3D, 2D frozen rotor with 
initialization; time 
dependent with 
initialization

Turbulent Flow, 
Spalart-Allmaras

— 3D, 2D frozen rotor with 
initialization; time 
dependent with 
initialization

Turbulent Flow, v2-f — 3D, 2D frozen rotor with 
initialization; time 
dependent with 
initialization

PHYSICS INTERFACE ICON TAG SPACE 
DIMENSION

AVAILABLE STUDY TYPE
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context-based) help, and the application libraries are all accessed through the 
COMSOL Desktop.

T H E  D O C U M E N T A T I O N  A N D  O N L I N E  H E L P

The COMSOL Multiphysics Reference Manual describes the core physics interfaces 
and functionality included with the COMSOL Multiphysics license. This book also has 
instructions about how to use COMSOL Multiphysics and how to access the 
electronic Documentation and Help content.

Opening Topic-Based Help
The Help window is useful as it is connected to the features in the COMSOL Desktop. 
To learn more about a node in the Model Builder, or a window on the Desktop, click 
to highlight a node or window, then press F1 to open the Help window, which then 
displays information about that feature (or click a node in the Model Builder followed 
by the Help button ( ). This is called topic-based (or context) help.

If you are reading the documentation as a PDF file on your computer, 
the blue links do not work to open an application or content 
referenced in a different guide. However, if you are using the Help 
system in COMSOL Multiphysics, these links work to open other 
modules, application examples, and documentation sets.

To open the Help window:

• In the Model Builder, Application Builder, or Physics Builder click a node or 
window and then press F1. 

• On any toolbar (for example, Home, Definitions, or Geometry), hover the 
mouse over a button (for example, Add Physics or Build All) and then 
press F1.

• From the File menu, click Help ( ).

• In the upper-right corner of the COMSOL Desktop, click the Help ( ) 
button.
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Opening the Documentation Window

T H E  A P P L I C A T I O N  L I B R A R I E S  W I N D O W

Each model or application includes documentation with the theoretical background 
and step-by-step instructions to create a model or app. The models and applications 
are available in COMSOL Multiphysics as MPH files that you can open for further 
investigation. You can use the step-by-step instructions and the actual models as 
templates for your own modeling. In most models, SI units are used to describe the 
relevant properties, parameters, and dimensions, but other unit systems are available.

Once the Application Libraries window is opened, you can search by name or browse 
under a module folder name. Click to view a summary of the model or application and 
its properties, including options to open it or its associated PDF document.

To open the Help window:

• In the Model Builder or Physics Builder click a node or window and then 
press F1.

• On the main toolbar, click the Help ( ) button.

• From the main menu, select Help>Help.

To open the Documentation window:

• Press Ctrl+F1.

• From the File menu select Help>Documentation ( ).

To open the Documentation window:

• Press Ctrl+F1.

• On the main toolbar, click the Documentation ( ) button.

• From the main menu, select Help>Documentation.

The Application Libraries Window in the COMSOL Multiphysics 
Reference Manual.
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Opening the Application Libraries Window
To open the Application Libraries window ( ):

C O N T A C T I N G  C O M S O L  B Y  E M A I L

For general product information, contact COMSOL at info@comsol.com.

C O M S O L  A C C E S S  A N D  T E C H N I C A L  S U P P O R T

To receive technical support from COMSOL for the COMSOL products, please 
contact your local COMSOL representative or send your questions to 
support@comsol.com. An automatic notification and a case number are sent to you by 
email. You can also access technical support, software updates, license information, and 
other resources by registering for a COMSOL Access account.

C O M S O L  O N L I N E  R E S O U R C E S

• From the Home toolbar, Windows menu, click ( ) Applications 

Libraries.

• From the File menu select Application Libraries.

To include the latest versions of model examples, from the File>Help 
menu, select ( ) Update COMSOL Application Library.

Select Application Libraries from the main File> or Windows> menus.

To include the latest versions of model examples, from the Help menu 
select ( ) Update COMSOL Application Library.

COMSOL website www.comsol.com

Contact COMSOL www.comsol.com/contact

COMSOL Access www.comsol.com/access

Support Center www.comsol.com/support

Product Download www.comsol.com/product-download

Product Updates www.comsol.com/support/updates

COMSOL Blog www.comsol.com/blogs

Discussion Forum www.comsol.com/community

Events www.comsol.com/events
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COMSOL Video Gallery www.comsol.com/video

Support Knowledge Base www.comsol.com/support/knowledgebase
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Ove r v i ew o f  t h e  U s e r ’ s  Gu i d e

The Mixer Module User’s Guide gets you started with modeling using COMSOL 
Multiphysics and provides information specific to this module. Further instructions on 
using COMSOL in general are found in the COMSOL Multiphysics Reference 
Manual. 

For general information about setting up and solving CFD applications, see the CFD 
Module User’s Guide.

The last section in this chapter features a model you can access from The Application 
Libraries Window. The Tutorial Example — Nonisothermal Mixer solves a mixer-flow 
problem using the Laminar Flow interface in the Rotating Machinery, Nonisothermal 
Flow branch.

The following chapter documents the Mixer Module Part Library. It includes an 
overview of the all included impellers and tanks.

The third chapter introduces you to the Theory for the Free Surface Features. It 
includes descriptions of the mesh deformation within the free surface domain and the 
conditions that need to be satisfied at a free surface, at a three-phase boundary, and on 
a rotating shaft within the free surface domain.

The remaining chapters describe the physics interfaces and features under the Rotating 
Machinery, Fluid Flow branch, and the additional branches exclusive to the Mixer 
Module: Rotating Machinery, Multiphase Flow Interfaces, Rotating Machinery, 
Nonisothermal Flow Interfaces, and Rotating Machinery, Reacting Flow Interfaces.

As detailed in the section Where Do I Access the Documentation? this 
information can also be found from the COMSOL Multiphysics software 
Help menu. 
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Tu t o r i a l  E x amp l e  — Non i s o t h e rma l  
M i x e r

This model demonstrates how to obtain the temperature distribution in a simplified 
tabletop lab mixer using the Rotating Machinery, Nonisothermal Flow branch in the 
Mixer Module. The key instructive element is a demonstration of the Frozen Rotor 

method, which substantially reduces the computational time for a mixing study.

The model geometry is shown in Figure 2-3. It represents a cross-section of a tabletop 
lab mixer. Small mixers are not always baffled. Instead, one or several rods are inserted 
through the mixer lid and function as baffles. The rods typically contain equipment to 
measure, for example, the temperature or pH level. In this model, the mixer is baffled 
by a simplified immersion heater, which has a constant surface temperature of 60°C.

Figure 2-3: Tabletop lab mixer geometry, showing the rotational direction of the impeller 
and the location of the immersion heater.

Immersion heater

Rotational
direction
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The mixer tank is filled with water which is agitated by the impeller rotating clockwise 
(as indicated in Figure 2-3) with 20 revolutions per minute (rpm). In this model the 
thickness of the impeller blades is significantly smaller than the diameter of the tank, 
and the impeller blades are therefore modeled as infinitely thin.

The tank is made of steel and is subjected to cooling by natural convection on the 
outside of the mixer vessel. The surrounding conditions corresponds to a temperature 
of 20°C and a pressure of 1 atmosphere. The total height of the reactor is 0.2 m. These 
conditions are needed as input for the natural convection correlations, which are used 
to calculate the heat transfer coefficient from the tank wall to the surroundings.

M O D E L  S E T U P

The Reynolds number for a mixer is commonly calculated as

 (2-1)

where N is the number of rotations per second, Da the impeller diameter, and ν the 
kinematic viscosity. A high Reynolds number means that the flow has a tendency to 
become turbulent. Evaluating Equation 2-1 using ν at 60 °C gives Re = 6944. This 
Reynolds number indicates that the flow is at least partly turbulent. For simplicity in 
this instructional model, the flow is assumed to be two-dimensional and no turbulence 
model is used. Possible extensions of the model includes to resolve it using the full 
three dimensional geometry, and also to apply a turbulence model to investigate the 
effect of turbulent structures occurring in the flow.

The objective of this model is to obtain the temperature distribution at operating 
conditions. One way to get there would be to start from zero velocity and a 
homogeneous temperature distribution and to simulate the start-up of the mixer. This 
approach is simple, but requires a relatively long computation time.

A computationally more efficient method is to first simulate the flow using the 
frozen-rotor approach. The frozen-rotor approach is a modeling concept that treats 
the rotor as fixed, or frozen in space. The flow in the rotating domain is assumed to be 
stationary in terms of a rotating coordinate system. The effect of the rotation is then 
accounted for by the Coriolis and centrifugal forces. The flow in the non-rotating parts 
is also assumed to be stationary, but in a non-rotating coordinate system. (See Frozen 
Rotor in the CFD Module User’s Guide for more information.) The result of a 
frozen-rotor simulation is an approximation to the flow induced by the impeller. The 
result depends on the angular position of the impeller and cannot represent transient 
effects. However, it is still a very good starting point to reach operating conditions.

Re
NDa

2

ν
-------------=
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Here the frozen-rotor result is used as input to a time-dependent simulation and the 
progress towards the operating conditions is monitored using probe plots.

R E S U L T S  A N D  D I S C U S S I O N

Figure 2-4 shows the velocity distribution obtained from the frozen-rotor simulation. 
As expected, the highest velocity magnitude is found at the tip of the mixer blades. 
Three recirculation zones can be identified: one downstream of the immersion heater, 
one along the top wall, and one along the bottom wall.

Figure 2-4: Velocity field obtained from the frozen rotor simulation.

Figure 2-5 shows the temperature distribution obtained from the frozen-rotor 
simulation. Streamlines are also included to visualize the flow field. The temperature 
is relatively homogeneous throughout the mixer. There are some cold spots in 
connection to the recirculation zones adjacent to the outer wall. This is expected 
because the fluid there has a longer residence time close to the solid wall, and therefore 
has less contact with the heated fluid closer to the center of the mixer.
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Figure 2-5: Temperature distribution obtained from the frozen-rotor simulation.

The progress of a solution can be monitored using probes (see Probes in the COMSOL 
Multiphysics Reference Manual). The velocity magnitude and temperature are 
probed at (x,y) = (−0.05,0.065). The location is indicated in Figure 2-5, just outside 
the recirculation zone along the top wall.

The probe plots produced during the time-dependent simulation are shown in 
Figure 2-6. The velocity probe plot shows that the flow pattern, after an initial 
transient, oscillates around the frozen-rotor result with an amplitude of about 10%. 
The deviations in temperature are much smaller.

The velocity probe plot clearly shows the frequency that corresponds to the passing of 
the blades (0.75 Hz) and an additional frequency (about 0.25 Hz) related to the 
intermittent boundary-layer separation. Evaluating the frequency from the Strouhal 
number for the immersion heater gives a value of about 0.25 Hz, suggesting that the 
boundary-layer separation may be induced by the Kármán vortex street behind the 
heater. The temperature value does not display the same frequencies and instead 
changes more smoothly.

Probe point
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Figure 2-6: Probe plots of velocity and temperature in the mixer from the time-dependent 
simulation.
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A more complete picture of the progress from the frozen-rotor solution toward the 
operating conditions can be seen through an animation. Figure 2-7 shows four 
snapshots from such an animation. The time runs from top left to bottom right. The 
most notable changes occur in the recirculation zones. The recirculation zone behind 
the immersion heater has two vortices which appear to be oscillating. This has no effect 
on the local temperature, but it significantly influences the size of the recirculation 
zones adjacent to the outer wall.

Looking at Figure 2-5, it can be seen that the recirculation zone along the top wall 
contains a single, large vortex. As the simulation progresses (t = 20 s to t = 40 s), the 
size and strength and position of the vortices along the top wall varies as a result of the 
interaction between the disturbance, produced by the immersion heater, and the outer 
wall.

Figure 2-7: Evolution of the temperature field from frozen rotor solution toward operating 
conditions.

The results obtained in this model are typical for rotating-machinery models: The 
frozen-rotor approach can, with minimal computational effort, deliver a decent 
approximation of the flow and temperature fields. But transient effects can only be 
 2 :  I N T R O D U C T I O N



captured with a time-dependent simulation, and these effects can change local 
temperature and velocity values significantly.

The remainder of this section consists of step-by-step instructions on setting up, 
solving, and analyzing the model using both analysis types.

M O D E L  W I Z A R D

The first step to build a model is to open COMSOL Multiphysics, then select the 
physics interface and specify the type of analysis you want to do — in this case, a 
frozen-rotor analysis using a Rotating Machinery, Nonisothermal Laminar Flow 
interface.

1 Open COMSOL Multiphysics. On the New page, click Model Wizard . Then click 
the 2D button .

2 In the Select Physics tree, under Fluid Flow>Nonisothermal Flow>Rotating Machinery, 

Nonisothermal Flow click Laminar Flow .

3 Click the Add button.

4 Click the Study button .

5 In the tree, select Preset Studies for Selected Physics Interfaces>Frozen Rotor .

6 Click the Done button .

C R E A T E  T H E  G E O M E T R Y

To simplify this step, insert a prepared geometry sequence. 

1 On the Geometry toolbar, select Insert Sequence . 

2 Browse to the module’s applications folder and double-click the file 
nonisothermal_mixer.mph.

3 Go to the Home toolbar and select Build All . The Home toolbar refers to the 
specific set of controls near the top of the Desktop.

4 Click the Zoom Extents button  on the Graphics toolbar.

M A T E R I A L S

On the Home toolbar, click Add Material .
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Water, liquid
1 Go to the Add Material window.

2 In the tree, select Built-In>Water, liquid.

3 In the Add Material window, click Add to Component .

Steel AISI 4340
1 Go to the Add Material window.

2 In the tree, select Built-In>Steel AISI 4340.

3 In the Add Material window, click Add to Component .

4 In the Model Builder, under Component 1 (comp1)>Materials click Steel AISI 4340.

5 In the Home toolbar, click Add Material  again to close the Add Material window.

6 Select Domain 1, the circular outer rim of the mixer, only.

There are many ways to select geometric entities. When you know the domain to add, 
such as in this exercise, you can click the Paste Selection button  and enter the 
information in the Selection text field. In this example, enter 1 in the Paste Selection 
window. For more information about selecting geometric entities in the Graphics 
window, see the COMSOL Multiphysics Reference Manual.
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D E F I N I T I O N S

Rotating Domain 1
1 In the Model Builder window, under Component 1 (comp1)>Definitions>Moving Mesh 

click Rotating Domain 1.

1 In the Settings window for Rotating Domain, locate the Domain Selection section.

2 In the list, choose 1 and 2.

3 Click Remove from Selection . Only domain 3, the impeller domain, is selected.

4 In the Settings window for Rotating Domain locate the Rotation section.

5 In the Revolutions per time text field, type -20[rpm].

L A M I N A R  F L O W  ( S P F )

1 In the Model Builder window, under Component 1 (comp1) click Laminar Flow (spf).

2 In the Settings window for Laminar Flow, locate the Domain Selection section.

3 In the list, select 1.

4 Click Remove from Selection . Only domains 2 and 3, the fluid domains, are 
selected.

Flow Continuity 1
1 In the Physics toolbar, in the Boundary section, click Pairs and choose 

Flow Continuity .

2 In the Settings window for Flow Continuity, locate the Pair Selection section.

3 In the Pairs list, select Identity Boundary Pair 1 (ap1).

Interior Wall 1
1 In the Physics toolbar, click Boundaries and choose Interior Wall .
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2 Select Boundaries 17–20 only, corresponding to the impeller blades.

Pressure Point Constraint 1
1 On the Physics toolbar, click Points and select Pressure Point Constraint .

2 Select Point 5 only. This is the bottommost point in the fluid domain of the mixer.

H E A T  T R A N S F E R  I N  F L U I D S  ( H T )

In the Model Builder window, under Component 1 (comp1) click 
Heat Transfer in Fluids (ht).

Solid 1
1 In the Physics toolbar, click Domains and choose Solid .

2 Select Domain 1, the mixer vessel wall, only.

Continuity 1
1 In the Physics toolbar, in the Boundary section, click Pairs and choose Continuity .

2 In the Settings window for Continuity, locate the Pair Selection section.

3 In the Pairs list, select Identity Boundary Pair 1 (ap1).

Temperature 1
1 In the Physics toolbar, click Boundaries and select Temperature .

2 Select Boundaries 13–16, which make up the boundary of the immersion heater.

3 In the Settings window for Temperature, locate the Temperature section.

4 In the T0 text field, type 60[degC].

Heat Flux 1
1 In the Physics toolbar, click Boundaries and choose Heat Flux .

2 Select Boundaries 1, 2, 7, and 12, which make up the circular outer boundary of the 
mixer vessel.

3 In the Settings window for Heat Flux, locate the Heat Flux section.

4 Click the Convective heat flux button.

5 From the Heat transfer coefficient list, choose External natural convection.

6 In the L text field, type 0.2[m].
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M E S H  1

1 In the Model Builder window, under Component 1 (comp1) click Mesh 1 .

2 In the Settings window for Mesh from the Element size list, select Fine.

The default mesh generates isotropic mesh elements across the thin vessel wall. Edit 
the Physics-controlled mesh settings to increase the element size in the circumferential 
direction of the solid domain.

1 Go to the Mesh toolbar and click Edit  .

2 In the Model Builder window, under Component 1 (comp1)>Mesh 1 click Size .

3 In the Settings window for Size, locate the Element Size section.

4 From the Predefined list, choose Coarse.

Free Triangular 1
1 In the Model Builder window, under Component 1 (comp1)>Mesh 1 click 

Free Triangular 1 .

Now, add a separate Size node with reduced resolution in narrow regions.

Size 1
1 Right-click Component 1 (comp1)>Mesh 1>Free Triangular 1 and choose Size .

2 In the Settings window for Size 1, locate the Geometric Entity Selection section.

3 From the Geometric entity level list, choose Domain.

4 Select Domain 1, the vessel wall, only.

5 Locate the Element Size section. Click the Custom button.

6 Locate the Element Size Parameters section. Select the Resolution of narrow regions 
check box.

7 In the associated text field, type 0.1.

Build the Free Triangular 1 mesh node in order to inspect the mesh at this point.

8 In the Settings window for Size 1, click the Build Selected button

Now add the mesh boundary layers as well. Use boundary layer mesh also in the solid 
domain to increase the resolution there.

Boundary Layers 1
1 In the Model Builder window, under Component 1 (comp1)>Mesh 1 click 

Boundary Layers 1 .

2 In the Settings window for Boundary Layers, locate the Domain Selection section.

3 From the Selection list, choose All domains.
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4 In the Settings window for Boundary Layers 1, click the Build Selected button .

Now that the physics is defined and the geometry is meshed, solve the model using the 
frozen rotor approach.

S T U D Y  1

In the Home toolbar, click Compute .

R E S U L T S

Re-create Figure 2-4 using the following steps.

Velocity (spf)
1 In the Model Builder window, under Results , click the Velocity (spf) node.

1 Right-click Velocity (spf) and choose Streamline .

2 In the Settings window for Streamline, locate the Streamline Positioning section.

3 From the Positioning list, choose Uniform density.

4 In the Separating distance text field, type 0.02.

5 Locate the Coloring and Style section. Find the Arrow style subsection. From the 
Color list, choose White.

6 In the Velocity (spf) toolbar, click Plot .

7 Click the Zoom Extents button  in the Graphics toolbar.

Figure 2-5 can be created by the following steps.

Temperature (ht)
1 n the Model Builder window, expand the Results>Temperature (ht) node, then click 

Surface .

2 In the Settings window for Surface, locate the Coloring and Style section.
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3 From the Color table list, choose Wave.

4 Go to the Temperature (ht) toolbar and select Streamline .

5 In the Settings window for Streamline, locate the Streamline Positioning section.

6 From the Positioning list, choose Uniform density.

7 In the Separating distance text field, type 0.02.

8 Locate the Coloring and Style section. Find the Arrow style subsection. From the 
Color list, choose Gray.

9 In the Temperature (ht) toolbar, click Plot .

Add a probe to follow the development of the flow during the time-dependent 
simulation.

D E F I N I T I O N S

Domain Point Probe 1
1 In the Definitions toolbar, click Probes and choose Domain Point Probe .

2 In the Settings window for Domain Point Probe, locate the Point Selection section.

3 In the Coordinates text field, set x to -0.05[m].

4 In the Coordinates text field, set y to 0.065[m]. 

The probe is located at the outer edge of the recirculation zone that is positioned 
along the upper wall. By default the flow field velocity magnitude is tracked by the 
probe. 

5 In the Model Builder window, expand the Domain Point Probe 1 node .

6 Right-click Point Probe Expression 1 (ppb1)  and choose Duplicate.
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7 In the Settings window for Point Probe Expression, locate the Expression section.

8 In the Expression text field, type T, in order to track the temperature variable.

9 Click to expand the Table and Window Settings section. From the Plot window list, 
choose New window.

Add a Time Dependent study in order to perform a transient simulation, using the 
previous solution as initial condition.

A D D  S T U D Y

1 In the Home toolbar, click Add Study  to open the Add Study window.

2 Go to the Add Study window.

3 In the tree, select General Studies>Time Dependent .

4 In the Add Study window, click Add Study .

5 In the Home toolbar, click Add Study  again to close the Add Study window.

S T U D Y  2

Step 1: Time Dependent
1 In the Model Builder window, under Study 2 click Step 1: Time Dependent .

2 In the Settings window for Time Dependent, locate the Study Settings section.

3 In the Times text field, type range(0,0.5,40).

This means that the solution will be computed from t = 0 to 40 s, and the solution 
will be stored every 0.5 seconds.

Now, apply the solution from the previous frozen rotor analysis as initial condition 
for the transient simulation.
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4 Click to expand the Values of Dependent Variables section. Find the 
Initial values of variables solved for subsection. From the Settings list, choose 
User controlled. 

5 From the Method list, choose Solution.

6 From the Study list, choose Study 1, Frozen Rotor.

For the transient simulation, add a restriction on the time step. This will make sure that 
the impeller rotation in each time step is bounded, and that a high accuracy is 
maintained throughout the simulation. First generate the solver sequence. 

Solution 2
1 In the Study toolbar, click Show Default Solver .

2 In the Model Builder window, expand the Solution 2 (sol2) node, then click 
Time-Dependent Solver 1 .

Apply a maximum time step of 0.05 s. This is equivalent to an impeller rotation of 
6º.

3 In the Settings window for Time-Dependent Solver, click to expand the Time Stepping 
section.

4 From the Maximum step constraint list, choose Constant.

5 In the Maximum step text field, type 0.05.

6 In the Study toolbar, click Compute .

Two probe plots are automatically displayed when you start the calculation.

R E S U L T S

The following steps create an animation that contains the plots in Figure 2-7.

Temperature (ht) 1
1 In the Model Builder window, under Results , click Temperature (ht) 1 .

2 In the Settings window for 2D Plot Group, locate the Plot Settings section.

Plot the data set edges in the spatial frame to make them follow the rotation.

3 From the Frame list, choose Spatial (x, y, z).

Surface
1 In the Model Builder window, expand the Temperature (ht) 1  node, then click 

Surface .

2 In the Settings window for Surface, locate the Coloring and Style section.

3 From the Color table list, choose Wave.
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Streamline 1
1 Go to the Temperature (ht) 1 toolbar and choose Streamline .

2 In the Settings window for Streamline, locate the Streamline Positioning section.

3 From the Positioning list, choose Uniform density.

4 In the Separating distance text field, type 0.02.

5 Locate the Coloring and Style section. Find the Arrow style subsection. From the 
Color list, choose Gray.

Animation 1
1 Go to the Results toolbar, click Animation  and choose File .

2 In the Settings window for Animation, locate the Target section.

3 From the Target list, choose Player.

4 Locate the Scene section. From the Subject list, choose Temperature (ht) 1.

5 Locate the Frames section. From the Frame selection list, choose All.

6 Locate the Playing section. In the Display each frame for text field, type 0.25.

7 In the Graphics window, click Play .
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M i x e r  M o d u l e  P a r t  L i b r a r y
In this chapter:

• Part Library Contents

• Tank Parts

• Impeller Parts
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Pa r t  L i b r a r y  Con t e n t s

The dedicated part library included in the Mixer Module contains geometrical parts 
typical of mixer and stirred vessel equipment. The included parts consists of impellers, 
tanks, and a straight cylindrical shaft. When accessing the library, the parts are sorted 
under the categories seen in the figure below

Figure 3-1: The Mixer Module Part Library

The dimensions and configuration of the different parts can be controlled to a great 
detail using the input parameters included in each part. For example, adding a pitched 
impeller part instance, you can cut different parts of the impeller, round its edges, 
define the pitch angle, and define asymmetrical blades, which are wider above the 
rotation plane than below. Also several impellers can be added, and also rotate them 
slightly around the rotational axis in order to evenly distribute the blades in the 
circumferential direction.
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T ank Pa r t s

The Mixer Module Part Library includes three different cylindrical tanks: a dished 
bottom tank, a flat bottom tank, and a cone bottom tank. The three tank types are 
shown in the figure below:

Figure 3-2: Tank parts available in the Mixer Module Part Library.

All tank parts can be defined to include an optional number of baffles in order to 
improve mixing. Baffles are specially required when radial impellers are used, in order 
to avoid a near solid body rotation of the fluid.

By default, the tank’s cylindrical part is positioned with its base at z = 0. This implies 
that the dished and cone bottom sections are positioned just below the xy-plane. If you 
define a flat bottom tank with a fillet radius on the lower cylinder edge, then also the 
fillet section created is placed just below the xy-plane. If you specify a zero fillet radius 
for a flat bottom tank, then the base of the tank is positioned in the xy-plane, that is, 
at z = 0.

The impeller shaft’s lowest part is also by default positioned at z = 0. You can change 
the position, length, and diameter of the impeller shaft. However, the impeller shaft is 
always placed in the middle of the tank perpendicular to the xy-plane.

Dished bottom tank Flat bottom tank Cone bottom tank
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Impe l l e r  Pa r t s

As seen in Figure 3-1, the impeller parts are sorted into three categories, depending 
on the principal direction of the flow generated by the impeller rotation (axial or radial 
flow), or if the impeller type is used to mix highly viscous fluids. In total, the Mixer 
Module Part Library includes eleven impellers: five axial impellers, four radial 
impellers, and two impellers for highly viscous fluids.

A X I A L  A N D  R A D I A L  I M P E L L E R S

Axial impellers give the flow an axial component naturally achieving mixing along the 
z-axis of the mixer. This type of mixers is appropriate for fluids that are sensitive to high 
shear rates. For example, fermentation processes have living cells in the reactor 
solution, cells that would be killed by high shear rates. In these processes, axial 
impellers are often selected and baffles are usually omitted.

Radial impellers force the flow in the radial direction and only give an axial component 
once the flow hits the walls of the vessel. In order to achieve good mixing, these 
impellers rely on high shear rates and the presence of baffles, that disrupts tangential 
flows that would lead to poor mixing.

The figure below shows an example of an axial and a radial impeller

Figure 3-3: Examples of an axial impeller (pitched impeller) and a radial impeller 
(Rushton turbine).

Axial impeller Radial impeller
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P I T C H E D  B L A D E  I M P E L L E R

The most common axial impeller is the pitched blade impeller; see Figure 3-4 below. 
This impeller can be configured for rectangular blades or for isosceles trapezoid-shaped 
blades. These blade shapes can be created with wider outer or inner edges.

Figure 3-4: Possible configuration of impeller blades for symmetrical blades.

In addition to the symmetrical blades, asymmetrical blades can also be created. In 
order to create asymmetrical blades, the upper part of the blade is made wider than the 
lower part (see Figure 3-5). The impeller can then be flipped vertically to have the 
wider part of the blade facing downward. The pitch angle of the impeller blades can 

Attachment to
the impeller hub

Larger outer
blade width

Smaller inner
blade width

Cut at the upper
and inner edges

Cut at the lower
and outer edges

Cut at the lower
and inner edges

Cut at the upper
and outer edges
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be varied between 0 and 90 degrees. The outer vertices of the outer edges can also be 
rounded using fillets.

Figure 3-5: Asymmetrical blade. The upper part of the blade is wider than the lower part.

The figure below contains the notations used for the pitched impeller in the part 
library. The full list of parameters together with their description is found in Table 3-1

Figure 3-6: Notations used for the pitched impeller.

P I T C H E D  I M P E L L E R  W I T H  B E N T  B L A D E S

Bent blades may be used to decrease the pitch at the outer part (away from the hub) 
of the impeller blade. Bending these parts gives a less aggressive pitch angle at the outer 
edges. Using the Mixer Module, the bending is restricted to the upper and outer edges 
of the impeller blades. The upper part can also be made wider than the lower part to 

Upper part of the blade
wider than lower part

Pitch angle
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obtain an asymmetrical blade. However, you can flip the impeller vertically to get a 
bend or wider part that faces downward.

Figure 3-7: Available blade bend and cut operations.

The vertices of the outer vertical edge can be rounded using fillets. The figure below 
shows an impeller with asymmetrical blades and rounded vertices.

Figure 3-8: Asymmetrical impeller blades with rounded outer (away from the hub) 
vertices.

Attachment to
the impeller hub

Rectangular
blade bend

Asymmetric
blade

Blade bend at the
upper and outer edges

Cut at the lower
and outer edges

Bend
angle

Cut at the upper
and inner edges

Fillets create 
a rounded bend

Cut upper and
inner edges
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The figure below contains the notations used for the pitched impeller with bent blades 
in the part library. The full list of parameters together with their description is found 
in Table 3-1

Figure 3-9: Notations used for the pitched impeller with bent blades.

P I T C H E D  B L A D E  I M P E L L E R  W I T H  C O N S T A N T  P I T C H

For regular pitched impellers, the pitch increases with the radius of the impeller blades, 
since the blade parts travel with increasing velocity with increasing radius. This means 
that if the impeller rotated in a fluid, but was allowed to move freely in the axial 
direction, the outer edge of a regular pitched impeller would want to travel at a higher 
axial velocity than the inner edge. This effect subjects the impeller blade to a high 
bending moment. The pitched impeller with constant pitch adapts the pitch angle with 
the increasing radius so that the outer and inner edges get the same axial velocity as the 
impeller rotates. 

As for the regular pitched impellers, the pitched impeller with constant pitch can be 
designed with isosceles trapezoid-shaped blade projections (the blades are not flat). 
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The blades can also be cut in both upper and lower edges to achieve different impeller 
configurations.

Figure 3-10: Pitched impellers with constant pitch with different blade shapes.

The inner pitch angle can be varied in order to change the axial and radial components 
of the flow induced by the impeller. The pitch angle is then automatically calculated to 
give a constant pitch.

Attachment to
the impeller hub

“Twisted”
rectangular blade

Smaller inner
blade width

Larger outer
blade width

Cut upper and
inner edges

Cut upper and
outer edges

Cut lower and
outer edges

Cut lower and
inner edges
I M P E L L E R  P A R T S  |  47



48 |  C H A P T E R
The outer vertices of the blades can be rounded, which gives additional freedom in the 
design of the impeller blades. The figure below shows a propeller created by using 
fillets and cuts and applying those on a pitched impeller with constant pitch.

Figure 3-11: Impeller of propeller type created using isosceles trapezoid-shaped blade 
projections and large fillet radii for the outer vertices of the blades.

The figure below contains the notations used for the pitched impeller with constant 
pitch in the part library. The full list of parameters together with their description is 
found in Table 3-1

Figure 3-12: Notations used for the pitched impeller with constant pitch.

H Y D R O F O I L  I M P E L L E R

Impellers with blades that are curved along the vertical edges are denoted hydrofoil 
impellers. These impellers are similar to the pitched blade impellers, but give an 
additional pressure difference across the impeller blade with an additionally lowered 
pressure on the convex side of the blade.

Fillet on upper
and outer vertex

Fillet on lower
and outer vertex

Large fillet radius
yields a propeller shape
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In addition to varying the curvature radius of the blades, the shape of the impeller 
blade projections can be varied to get the same freedom in the design of hydrofoil 
impellers as for the case of the pitched impeller mentioned above. This implies that 
isosceles trapezoid-shaped blade projections, asymmetrical blades with a wider upper 
part, and cut blades can be used to create the desired design. Fillets make it possible to 
create impellers of propeller type. 

As in the case for the pitched impeller type, the pitch angle can be varied to control the 
relation between the radial and axial flow created as the impeller rotates.

Figure 3-13: The curved blades can be shaped to create a large variety of impeller designs.

Rectangular curved
blade with attachment at the hub

Asymmetrical blade with wider
upper part of the blade

Curved
blades 

Flip
vertical

Flip
horizontal

Large fillet
radius

Cut upper and
inner edges

Cut lower and
outer edges
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The figure below contains the notations used for the hydrofoil impeller in the part 
library. The full list of parameters together with their description is found in Table 3-1

Figure 3-14: Notations used for the hydrofoil impeller.

H Y D R O F O I L  I M P E L L E R  W I T H  C O N S T A N T  P I T C H

In the same fashion as for the pitched impeller, the hydrofoil impeller creates an axial 
flow velocity that increases with the impeller radius as the impeller rotates. This effect 
subjects the impeller blade to a bending moment. A hydrofoil impeller with constant 
pitch adapts the pitch angle in order to obtain an almost constant pitch of the 
projection of the curved blade along the radius of the impeller blades. Note that it is 
not possible (at least not easy) to obtain an exactly constant pitch with increasing radius 
for the hydrofoil impeller since the blades are curved.

As in the case for the regular hydrofoil impellers, the hydrofoil impeller with constant 
pitch gives an additional pressure difference across the impeller blade with an 
additionally lowered pressure on the convex side of the blade.
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The impeller blade can be designed with cut blades and asymmetrical blades. Fillets can 
be used to obtain impellers of propeller type.

Figure 3-15: Hydrofoil impellers with constant pitch.

The figure below contains the notations used for the hydrofoil with constant pitch 
impeller in the part library. The full list of parameters together with their description 
is found in Table 3-1

Figure 3-16: Notations used for the hydrofoil with constant pitch.

T H E  C - S H A P E D  D O U B L E  B L A D E  I M P E L L E R

This is an axial impeller that is suitable for fluids with relatively high viscosity. It consists 
of two pitched blades equipped with a c-shaped double-blade part that adds shear at 

Rectangular curved
and twisted blade

Cut upper and
inner edges

Cut lower and
outer edges

Cut wider
outer edge

Large fillet
radius

Cut lower and
outer edges with fillets
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the outer radius of the impeller. This impeller can be used to create the so-called 
Intermig® impeller.

The impeller can be designed with different pitch angles on the arms of the impeller. 
Also the angles of the c-shaped part can be varied. The profile can be changed by 
changing the vertical angle of the c-shaped part but keeping the upper and lower 
blades parallel. In addition, also the angle of the back of the “c” can be varied, keeping 
the lower and upper blades parallel but displacing them in the x-y plane.

Figure 3-17: The c-shaped with double blades impeller.

C-shaped
double blade

Adapt for clockwise
and counterclockwise rotation

Varying angle of
c-shaped profile

Varying pitch angle

Impeller arm
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The figure below contains the notations used for the c-shaped double blade impeller 
in the part library. The full list of parameters together with their description is found 
in Table 3-1

Figure 3-18: Notations used for the c-shaped double blade impeller.

R U S H T O N  T U R B I N E

Axial impellers, such as the Rushton turbine, work by pumping the fluid toward the 
walls of the vessel and then let the collision of the fluid with the wall supply the axial 
mixing and the turbulence required for mixing. In order to avoid a tangential flows 
that would result in a poor mixing, baffles are often used in combination with Rushton 
turbines. Rushton turbines induce a relatively high shear rate and therefore appropriate 
in processes where the fluid is not sensitive to shear rates.

The turbine can be designed with different blade lengths and also with different disk 
diameters.

Figure 3-19: The Rushton turbine.

Impeller blade

Impeller disk
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The figure below contains the notations used for the Rushton turbine in the part 
library. The full list of parameters together with their description is found in Table 3-1

Figure 3-20: Notations used for the Rushton turbine.

T H E  R U S H T O N  T U R B I N E  W I T H  B A C K S W E P T  B L A D E S

This type of impeller is similar to the Rushton turbine. The backswept blades allow for 
a smoother operation with lower shear rates. It is possible to vary the blade length, the 
disk diameter, as well as the curvature and blade angle relative to the perimeter of the 
disk.

Figure 3-21: The Rushton turbine with backswept blades.

Direction of
rotation Impeller disk

Impeller blade
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The figure below contains the notations used for the Rushton turbine with backswept 
blades in the part library. The full list of parameters together with their description is 
found in Table 3-1

Figure 3-22: Notations used for the Rushton turbine with backswept blades.

T H E  S M I T H  T U R B I N E

This is also an impeller that resembles the Rushton turbine. It has the same properties 
as the Rushton turbine but with a somewhat smoother operation with lower shear 
rates. The length of the blades, the diameter of the disk, as well as the radius of the 
curvature of the blades can be varied when creating the impeller geometry.

Figure 3-23: The Smith turbine.

Impeller blade

Direction of
rotation Impeller disk
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The figure below contains the notations used for the Smith turbine in the part library. 
The full list of parameters together with their description is found in Table 3-1

Figure 3-24: Notations used for the Smith turbine.

T H E  B A C K S W E P T  B L A D E  I M P E L L E R

This impeller type is suitable for fluids with low viscosity and density (for example, 
gases). The curvature of the blades create smooth operating conditions with relatively 
small shear rates compared to straight blades. The impeller can be designed with 
different blade lengths and curvatures of the blades.

Figure 3-25: The backswept impeller.

Direction of
rotation

Curvature
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Attachment to the hub

Impeller
blade
 3 :  M I X E R  M O D U L E  P A R T  L I B R A R Y



The figure below contains the notations used for the backswept blade impeller in the 
part library. The full list of parameters together with their description is found in 
Table 3-1

Figure 3-26: Notations used for the backswept blade impeller.

A N C H O R  I M P E L L E R

This impeller type is suitable for mixing fluids of very high viscosity. For example, this 
impeller is common when mixing Portland concrete and paints in small scales.The 
lower part of the impeller is shaped as an ellipse that is cut in the middle. The major 
axis of the ellipse equals the impeller diameter while the minor axis equals to the dished 
tank where the impeller is placed minus the clearance between the impeller and tank 
wall.

Figure 3-27: Anchor impeller.

Minor axis

Major axis

Upper hub
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The figure below contains the notations used for the anchor impeller in the part library. 
The full list of parameters together with their description is found in Table 3-1

Figure 3-28: Notations used for the anchor impeller.

Impeller Parameters

The table below contains the names and descriptions of the input parameter used for 
the impellers in the Mixer Module Part Library.

TABLE 3-1:  MIXER MODULE PART LIBRARY PARAMETERS

ab_ib Bending angle of folded section

ac_h_s_ib Shear angle, back of c-shape blades

ac_ib Vertical angle between arm and c-shaped blade

ac_s_ib Internal angle, c-shaped profile

ap_ib Pitch angle of impeller blade

ar_ib Rake angle of impeller

as_ib Relative rotation angle around shaft

d_a_ib Diameter of attachment section

d_hu Impeller hub diameter

d_id Diameter of impeller dish

d_im Impeller diameter

d_is Impeller shaft diameter

d_ta Tank diameter

Da d_im Input diameter for turbulence model

db_im Distance of first impeller hub from bottom

dc_ib Blade width, c-shaped blades

h_an_im Height of anchor impeller

hp_im Impeller position
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hp_is Position of the lowest part of the impeller shaft

l_ib Length of the impeller blades, Rushton, Smith

lc_ib Blade length, c-shaped blades

lr_bu_ib Relative position of the bending point along the length of 
the upper edge of the impeller blade

lr_cl_ib Relative position of cutting point along the length of the 
lower edge

lr_cu_ib Relative position of cutting point along the length of the 
upper edge

n_ib Number of blades

pa_rd_im Parameter that controls the impeller blade direction: 
1 = clockwise and -1 = counterclockwise

pa_ud_im Flip impeller vertically

rc_h_ib Curvature of backswept Rushton, Smith, and Backswept 
impeller

rc_v_ib Hydrofoil curvature radius closest to the hub

rf_ib Fillet radius of outer vertices

w_a_ib Blade attachment width

w_bou_ib Width of the folded section at the outer edge

w_cil_ib Width of inner and lower cut

w_ciu_ib Width of inner and upper cut

w_col_ib Width of outer and lower cut

w_cou_ib Width of outer and upper cut

w_ib Impeller blade width

w_o_ib Outer impeller width

wc_ib Blade distance, c-shaped blades

wc_o_ib Outer arm width for c-shaped impeller

wr_ai_ib Ratio between blade width and blade attachment

wr_asu_ib Asymmetry factor for upper part of the width of the 
impeller blade: 1 = symmetry, >1 = wider upper part

TABLE 3-1:  MIXER MODULE PART LIBRARY PARAMETERS
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M i x e r  M o d u l e  T h e o r y
In this chapter:

• Theory for the Free Surface Features
 61
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Th eo r y  f o r  t h e  F r e e  S u r f a c e  F e a t u r e s

In this section:

• Deforming Domain

• Free Surface Conditions

• Contact Angle

• Rotating Shaft Conditions

• References for the Free Surface Features

Deforming Domain

The mesh within the free surface domain is deformed to account for the movement of 
the free surface. This mesh movement is accomplished using a moving mesh approach. 
The software perturbs the mesh nodes so that they conform with the free surface and 
with other moving or stationary boundaries in the model. The boundary displacement 
is propagated throughout the domain to obtain a smooth mesh deformation 
everywhere. This is done by solving PDEs for the mesh displacements, using the 
movement of the free surface as boundary condition. Taking two dimensions as an 
example, a location in the deformed mesh with coordinates (x, y) can be related to its 
coordinates in the original undeformed mesh (X,Y) by a function on the form:

The original, undeformed, mesh is referred to as the material frame (or reference 
frame), while the deformed mesh is called the spatial frame. COMSOL Multiphysics 
also defines geometry and mesh frames, which are coincident with the material frame 
for this physics interface.

Theory for the Rotating Machinery Interfaces and Theory for the 
Nonisothermal Flow and Conjugate Heat Transfer Interfaces in the CFD 
Module User’s Guide.

The links to the physics features described in other guides do not work in 
the PDF, only from the online help in COMSOL Multiphysics.

x x X Y t, ,( )          y, y X Y t, ,( )= =
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For the Rotating Machinery interfaces the fluid-flow equations (along with other 
coupled equations such as heat or chemical species transport) are solved in the spatial 
frame in which the mesh is perturbed.

A number of mesh smoothing methods are available: Yeoh (the default), Laplace, 
Winslow, and Hyperelastic. Note that the equations used for each smoothing type have 
different properties. 

Free Surface Conditions

The Free Surface feature assumes that the density and viscosity of the fluid outside the 
domain are negligible compared to the corresponding values inside the domain. On 
the free surface the following condition for the stress, τ, along the surface is applied:

 (4-1)

Here pext is the pressure outside the free surface domain (SI unit: Pa) and fst denotes 
the surface tension forces (SI unit: N/m2). In the surface tension terms, ∇s is the 
surface gradient operator (∇s = (I − ni ni

T)∇ where I is the identity matrix) and σ is 
the surface tension coefficient (SI unit: N/m).

The mesh velocity at the free surface is defined as the fluid velocity in the direction 
normal to the surface:

 (4-2)

Contact Angle

At a three-phase boundary, it is necessary to add force terms to ensure that the fluid 
maintains a consistent contact angle. The forces acting at the contact point are applied 
to the fluid by the Contact Angle node (added per default under a Free Surface node). 
In equilibrium, the surface tension forces and the normal restoring force from the 
surface are in balance at a contact angle (θc), as shown in Figure 4-1. This equilibrium 
is expressed by Young's equation, which considers the components of the forces in the 
plane of the surface:

 (4-3)

Deformed Geometry and Moving Mesh in the COMSOL Multiphysics 
Reference Manual

ni τ⋅ pextn– i fst+ pextn– i σ+ ∇s ni⋅( )ni ∇sσ–= =

umesh n⋅( ) u n⋅( )=

σ θc( )cos γs1+ γs2=
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where σ is the surface tension between the two fluids, γs1 is the surface energy density 
on the wetted side, and γs2 the surface energy density on the other side of the 
two-phase interface.

Figure 4-1: The forces acting at a contact point. In equilibrium, the surface tension forces 
and the normal restoring force from the surface are in balance at a contact angle θc.

There is still debate in the literature as to precisely what occurs in non-equilibrium 
situations (for example, drop impact) when the physical contact angle deviates from 
the contact angle specified by Young’s equation. A simple approach, is to assume that 
the unbalanced part of the in-plane Young force acts on the fluid to move the contact 
angle toward its equilibrium value (Ref. 1). COMSOL Multiphysics employs this 
approach as it is physically motivated and is consistent with the thermodynamics 
allowed form of the boundary condition (Ref. 2, Ref. 3).

The normal force balance at the solid surface is handled by the wall boundary 
condition, which automatically prevents fluid flow across the solid boundary through 
a no-penetration condition. The wall fluid interface feature applies a force, fwf, on the 
fluid at the interface:

where θ is the actual contact angle and ms is the binormal to the solid surface.

Rotating Shaft Conditions

Using a Rotating Shaft feature, the velocity of the shaft boundary is defined by 
assuming solid body rotation of the shaft. The wall velocity is hence a function of the 
angular velocity w (SI unit: rad/s) of the shaft, and the (spatial frame) position x:

 (4-4)

fwf σ θc( )cos θ( )cos–( )ms=

uw w
rax
rax
---------- x rbp–( )×=
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where rax and rbp is the rotation axis direction and rotation base point, respectively.

References for the Free Surface Features
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 5
R o t a t i n g  M a c h i n e r y ,  F l u i d  F l o w
The Rotating Machinery, Laminar Flow (spf) and Rotating Machinery, Turbulent Flow 

(spf) interfaces, found under the Single-Phase Flow>Rotating Machinery branch ( ) 
when adding a physics interface, are used for modeling flow where one or more of 
the boundaries rotate in a periodic fashion. This is used for mixers and propellers.

The physics interfaces support compressible, weakly compressible and 
incompressible flow, the flow of non-Newtonian fluids described by the Power Law, 
Carreau Bingham-Papanastasiou, Herschel-Bukley-Papanastasiou, and 
Casson-Papanastasiou models, as well as turbulent flow. In addition, the physics 
interfaces support creeping flow, although the shallow channel approximation is 
redundant.

In this chapter:

• Moving Mesh

• The Rotating Machinery, Laminar Flow Interface

• The Rotating Machinery, Turbulent Flow, Algebraic yPlus Interface

• The Rotating Machinery, Turbulent Flow, L-VEL Interface

• The Rotating Machinery, Turbulent Flow, k-ε Interface

• The Rotating Machinery, Turbulent Flow, Realizable k-ε Interface
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• The Rotating Machinery, Turbulent Flow, k-ω Interface

• The Rotating Machinery, Turbulent Flow, SST Interface

• The Rotating Machinery, Turbulent Flow, Low Re k-ε Interface

• The Rotating Machinery, Turbulent Flow, Spalart-Allmaras Interface

• The Rotating Machinery, Turbulent Flow, v2-f Interface

• Domain, Boundary, Point, and Pair Nodes for the Rotating Machinery Interfaces
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Th e  Ro t a t i n g  Ma ch i n e r y ,  F l u i d  F l ow 
I n t e r f a c e s

Moving Mesh

The Rotating Machinery, Fluid Flow interfaces rely on ALE (Arbitrary Lagrangian 
Eulerian) moving mesh functionality for their rotating domain and free surface 
implementation.

R O T A T I N G  D O M A I N S

When a Rotating Machinery, Fluid Flow interface is added using the Model Wizard, a 
Rotating Domain node is added automatically in the Model Builder under the 
Definitions>Moving Mesh node. It contains settings for specifying the rotation of one or 
several domains. By default, All domains are selected. Under the Rotating Domain, you 
can exclude any non-rotating fluid domains. For both 3D and 2D components, the 
Rotation type should be set to Specified rotational velocity.

Select a Rotational velocity expression — General revolutions per time (the default), 
Constant revolutions per time, General angular velocity, or Constant angular velocity.

• For Constant revolutions per time, or General revolutions per time, enter a value or 
expression respectively in the Revolutions per time input field and optionally an Initial 

angle. The angular velocity in this case is defined as the input multiplied by 2·π.

• For Constant angular velocity, or General angular velocity enter a value or an 
expression respectively in the Angular velocity input field and optionally an Initial 

angle.

3D Components
For 3D components, select the Rotation axis base point, rax. The default is the origin. 
Select the Rotation axis, urot, the z-axis is the default. If the x-axis is selected, it 
corresponds to a rotational axis (1, 0, 0) with the origin as the base point, and 
correspondingly for the y-axis and z-axis.

2D Components
For 2D components, enter coordinates for the Rotation axis base point, rax. The 
default is the origin (0, 0).
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D E F O R M I N G  D O M A I N

When using the Free Surface feature, a Deforming Domain must first be added in the 
Model Builder under the Definitions>Moving Mesh node. Within the Deforming Domain, 
the mesh position is solved for to match the current position of the free surface. On 
external boundaries not defined as a free surface, the mesh is constrained to move only 
in the tangential direction. On boundaries which are internal with respect to the fluid 
(separating deforming domains from ordinary fluid domains), the mesh is constrained 
to its initial position.

If there is more than one deforming domain, these must not intersect. Also a 
deforming domain cannot intersect with a rotating domain.

Mesh Smoothing Type
This setting controls the method used to solve for the mesh displacement within 
deforming domains. The Mesh smoothing type can be chosen to be Laplace, Winslow, 
Hyperelastic, or Yeoh (the default) smoothing. Note that the equations used for each 
smoothing type have different properties. For the Yeoh mesh smoothing type, also 
specify a Stiffening factor (default: 10). See Smoothing Methods in the COMSOL 
Multiphysics Reference Manual for more information.

The Rotating Machinery, Laminar Flow Interface

The Rotating Machinery, Laminar Flow (spf) interface ( ), found under the 
Single-Phase Flow>Rotating Machinery branch ( ), is used to simulate flow at low to 
moderate Reynolds numbers in geometries with one or more rotating parts. The 
physics interface supports incompressible, weakly compressible and compressible flows 
at low Mach numbers (typically less than 0.3). It also supports modeling of 
non-Newtonian fluids. The physics interface is available for 3D and 2D components.

There are two study types available for this physics interface. Using the Time Dependent 
study type, rotation is achieved through moving mesh functionality, also known as 
sliding mesh. Using the Frozen Rotor study type, the rotating parts are kept frozen in 
position, and rotation is accounted for by the inclusion of centrifugal and Coriolis 
forces. In both types, the momentum balance is governed by the Navier-Stokes 
equations, and the mass conservation is governed by the continuity equation. See 
Theory for the Rotating Machinery Interfaces in the CFD Module User’s Guide.

Free Surface
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When this physics interface is added, the following default physics nodes are also added 
in the Model Builder under Laminar Flow — Fluid Properties, Wall and Initial Values. A 
Moving Mesh interface with a Rotating Domain node is added automatically in the Model 

Builder under the Definitions node. Then, from the Physics toolbar, add other nodes 
that implement, for example, boundary conditions and volume forces. You can also 
right-click Laminar Flow to select physics features from the context menu. See Domain, 
Boundary, Pair, and Point Nodes for Single-Phase Flow in the CFD Module User’s 
Guide.

S E T T I N G S

The Label is the default physics interface name. 

The Name is used primarily as a scope prefix for variables defined by the physics 
interface. Refer to such physics interface variables in expressions using the pattern 
<name>.<variable_name>. In order to distinguish between variables belonging to 
different physics interfaces, the name string must be unique. Only letters, numbers, and 
underscores (_) are permitted in the Name field. The first character must be a letter.

The default Name (for the first physics interface in the model) is spf.

In addition to the settings described below, see The Creeping Flow, Laminar Flow, 
Turbulent Flow, and Large Eddy Simulation Interfaces in the CFD Module User’s 
Guide for all the other settings available. See Domain, Boundary, Point, and Pair 
Nodes for the Rotating Machinery Interfaces for links to all the physics nodes.

A D V A N C E D  S E T T I N G S

To display this section, click the Show button ( ) and select Advanced Physics Options. 
Normally these settings do not need to be changed.

Pseudo time stepping
Select the Use pseudo time stepping for stationary equation form check box to add 
pseudo time derivatives to the equation when the Frozen Rotor equation form is used. 
(Frozen rotor is a pseudo stationary formulation.) When selected, also choose a CFL 

Pseudo Time Stepping for Laminar Flow Models in the CFD Module 
User’s Guide

Laminar Flow in a Baffled Stirred Mixer: Application Library path 
CFD_Module/Single-Phase_Tutorials/baffled_mixer
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number expression — Automatic (the default) or Manual. Automatic sets the local CFL 
number (from the Courant–Friedrichs–Lewy condition) to the built-in variable 
CFLCMP which in turn triggers a PID regulator for the CFL number. For Manual enter 
a Local CFL number CFLloc (dimensionless).

The Rotating Machinery, Turbulent Flow, Algebraic yPlus Interface

The Rotating Machinery, Turbulent Flow, Algebraic yPlus (spf) interface ( ), found 
under the Single-Phase Flow>Rotating Machinery branch ( ) when adding a physics 
interface, is used to simulate flow at high Reynolds numbers in geometries with one or 
more rotating parts. The physics interface is suitable for incompressible, weakly 
compressible and compressible flows at low Mach numbers (typically less than 0.3).

The equations solved by the Turbulent Flow, Algebraic yPlus interface are the 
Reynolds-averaged Navier-Stokes (RANS) equations for conservation of momentum, 
the continuity equation for conservation of mass, and an algebraic equation for the 
scaled wall distance. Turbulence effects are included using an enhanced viscosity model 
based on the scaled wall distance, and the physics interface therefore includes a wall 
distance equation.

Two study types are available for this physics interface. Using the Time Dependent with 

Initialization study type, the rotation is achieved through moving mesh functionality, 
also known as sliding mesh. Using the Frozen Rotor with Initialization study type, the 
rotating parts are kept frozen in position, and the rotation is accounted for by the 
inclusion of centrifugal and Coriolis forces. Both study types includes an initial Wall 
Distance Initialization step in order to compute the wall distance. See Theory for the 
Rotating Machinery Interfaces in the CFD Module User’s Guide.

When this physics interface is added, the following physics nodes are also added in the 
Model Builder under Turbulent Flow, Algebraic yPlus — Fluid Properties, Wall and Initial 

Values. A Moving Mesh interface with a Rotating Domain node is added automatically in 
the Model Builder under the Definitions node. Then, from the Physics toolbar, add other 
nodes that implement, for example, boundary conditions and volume forces. You can 
also right-click Turbulent Flow, Algebraic yPlus to select physics features from the 
context menu. For information about the available physics features, see Domain, 
Boundary, Point, and Pair Nodes for the Rotating Machinery Interfaces.

A part for the settings below, see the advanced settings for The Rotating Machinery, 
Laminar Flow Interface, and The Creeping Flow, Laminar Flow, Turbulent Flow, and 
Large Eddy Simulation Interfaces in the CFD Module User’s Guide. 
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T U R B U L E N C E  M O D E L  P A R A M E T E R S

The turbulence model parameters for the Algebraic yPlus model, κa and Ba, have been 
optimized for turbulent pipe flow. For certain cases, better performance can be 
obtained by tuning the model parameters.

D E P E N D E N T  V A R I A B L E S

The following dependent variables (fields) are defined for this physics interface:

• Velocity field u

• Pressure p

• Reciprocal wall distance G

• Wall distance in viscous units yPlus (dimensionless)

The Rotating Machinery, Turbulent Flow, L-VEL Interface

The Rotating Machinery, Turbulent Flow, L-VEL (spf) interface ( ), found under the 
Single-Phase Flow>Rotating Machinery branch ( ) when adding a physics interface, is 
used to simulate flow at high Reynolds numbers in geometries with one or more 
rotating parts. The physics interface is suitable for incompressible, weakly compressible 
and compressible flows at low Mach numbers (typically less than 0.3).

The equations solved by the Turbulent Flow, L-VEL interface are the 
Reynolds-averaged Navier-Stokes (RANS) equations for conservation of momentum, 
the continuity equation for conservation of mass, and an algebraic equation for the 
scaled fluid flow velocity tangential to the nearest wall. Turbulence effects are included 
using an enhanced viscosity model based on the scaled wall distance, and the physics 
interface therefore includes a wall distance equation.

Two study types available for this physics interface. Using the Time Dependent with 

Initialization study type, the rotation is achieved through moving mesh functionality, 
also known as sliding mesh. Using the Frozen Rotor with Initialization study type, the 
rotating parts are kept frozen in position, and the rotation is accounted for by the 
inclusion of centrifugal and Coriolis forces. Both study types includes an initial Wall 
Distance Initialization step in order to compute the wall distance. See Theory for the 
Rotating Machinery Interfaces in the CFD Module User’s Guide.

When this physics interface is added, the following physics nodes are also added in the 
Model Builder under Turbulent Flow, L-VEL — Fluid Properties, Wall, and Initial Values. A 
Moving Mesh interface with a Rotating Domain node is added automatically in the Model 

Builder under the Definitions node. Then, from the Physics toolbar, add other nodes 
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that implement, for example, boundary conditions and volume forces. You can also 
right-click Turbulent Flow, L-VEL to select physics features from the context menu. For 
information about the available physics features, see Domain, Boundary, Point, and 
Pair Nodes for the Rotating Machinery Interfaces.

A part for the interface settings defined below, see the advanced settings for The 
Rotating Machinery, Laminar Flow Interface, and the settings in The Creeping Flow, 
Laminar Flow, Turbulent Flow, and Large Eddy Simulation Interfaces in the CFD 
Module User’s Guide.

T U R B U L E N C E  M O D E L  P A R A M E T E R S

The turbulence model parameters for the L-VEL model, κl and El, have been 
optimized for internal flow. For certain cases, better performance can be obtained by 
tuning the model parameters.

D E P E N D E N T  V A R I A B L E S

The following dependent variables (fields) are defined for this physics interface:

• Velocity field u

• Pressure p

• Reciprocal wall distance G

• Tangential velocity in viscous units uPlus (dimensionless)

The Rotating Machinery, Turbulent Flow, k-ε Interface

The Rotating Machinery, Turbulent Flow, k-ε (spf) interface ( ), found under the 
Single-Phase Flow>Rotating Machinery branch ( ) when adding a physics interface, is 
used to simulate flow at high Reynolds numbers in geometries with one or more 
rotating parts. The physics interface is suitable for incompressible, weakly compressible 
and compressible flows at low Mach numbers (typically less than 0.3).

The momentum balance is governed by the Navier-Stokes equations, and the mass 
conservation is governed by the continuity equation. Turbulence effects are modeled 
using the standard two-equation k-ε model with realizability constraints. Flow close to 
walls is modeled using wall functions.

There are two study types available for this physics interface. Using the Time Dependent 
study type, the rotation is achieved through moving mesh functionality, also known as 
sliding mesh. Using the Frozen Rotor study type, the rotating parts are kept frozen in 
position, and the rotation is accounted for by the inclusion of centrifugal and Coriolis 
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forces. See Theory for the Rotating Machinery Interfaces in the CFD Module User’s 
Guide.

When this physics interface is added, the following physics nodes are also added in the 
Model Builder under Turbulent Flow, k-ε — Fluid Properties, Wall and Initial Values. A 
Moving Mesh interface with a Rotating Domain node is added automatically in the Model 

Builder under the Definitions node. Then, from the Physics toolbar, add other nodes 
that implement, for example, boundary conditions and volume forces. You can also 
right-click Turbulent Flow, k-ε to select physics features from the context menu. For 
information about the available physics features, see Domain, Boundary, Point, and 
Pair Nodes for the Rotating Machinery Interfaces.

A part for the defined settings below, see the advanced settings for The Rotating 
Machinery, Laminar Flow Interface, and the settings in The Creeping Flow, Laminar 
Flow, Turbulent Flow, and Large Eddy Simulation Interfaces in the CFD Module 
User’s Guide. 

T U R B U L E N C E  M O D E L  P A R A M E T E R S

Turbulence model parameters are optimized to fit as many flow types as possible, but 
for some special cases, better performance can be obtained by tuning the model 
parameters.

For this physics interface the parameters are Ce1, Ce2, Cμ, σk, σe, κv, and B.

D E P E N D E N T  V A R I A B L E S

The following dependent variables (fields) are defined for this physics interface:

• Velocity field u and its components 

• Pressure p

• Turbulent kinetic energy k 

• Turbulent dissipation rate ep 

The Rotating Machinery, Turbulent Flow, Realizable k-ε Interface

The Rotating Machinery, Turbulent Flow, Realizable k-ε (spf) interface ( ), found 
under the Single-Phase Flow>Rotating Machinery branch ( ) when adding a physics 
interface, is used to simulate flow at high Reynolds numbers in geometries with one or 
more rotating parts. The physics interface is suitable for incompressible, weakly 
compressible and compressible flows at low Mach numbers (typically less than 0.3).
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The momentum balance is governed by the Navier-Stokes equations, and the mass 
conservation is governed by the continuity equation. Turbulence effects are modeled 
using the Realizable two-equation k-ε model. Flow close to walls is modeled using wall 
functions.

There are two study types available for this physics interface. Using the Time Dependent 
study type, the rotation is achieved through moving mesh functionality, also known as 
sliding mesh. Using the Frozen Rotor study type, the rotating parts are kept frozen in 
position, and the rotation is accounted for by the inclusion of centrifugal and Coriolis 
forces. See Theory for the Rotating Machinery Interfaces in the CFD Module User’s 
Guide.

When this physics interface is added, the following physics nodes are also added in the 
Model Builder under Turbulent Flow, Realizable k-ε — Fluid Properties, Wall and Initial 

Values. A Moving Mesh interface with a Rotating Domain node is added automatically in 
the Model Builder under the Definitions node. Then, from the Physics toolbar, add other 
nodes that implement, for example, boundary conditions and volume forces. You can 
also right-click Turbulent Flow, Realizable k-ε to select physics features from the context 
menu. For information about the available physics features, see Domain, Boundary, 
Point, and Pair Nodes for the Rotating Machinery Interfaces.

A part for the defined settings below, see the advanced settings for The Rotating 
Machinery, Laminar Flow Interface, and the settings in The Creeping Flow, Laminar 
Flow, Turbulent Flow, and Large Eddy Simulation Interfaces in the CFD Module 
User’s Guide. 

T U R B U L E N C E  M O D E L  P A R A M E T E R S

Turbulence model parameters are optimized to fit as many flow types as possible, but 
for some special cases, better performance can be obtained by tuning the model 
parameters.

For this physics interface the parameters are C2, A0, σk, σe, κv, and B.

D E P E N D E N T  V A R I A B L E S

The following dependent variables (fields) are defined for this physics interface:

• Velocity field u and its components 

• Pressure p

• Turbulent kinetic energy k 

• Turbulent dissipation rate ep
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The Rotating Machinery, Turbulent Flow, k-ω Interface

The Rotating Machinery, Turbulent Flow, k-ω (spf) interface ( ), found under the 
Single-Phase Flow>Rotating Machinery branch ( ) when adding a physics interface, is 
used to simulate flow at high Reynolds numbers in geometries with one or more 
rotating parts. The physics interface supports incompressible, weakly compressible and 
compressible flows at low Mach numbers (typically less than 0.3). The physics interface 
is available for 3D and 2D components.

The momentum balance is governed by the Navier-Stokes equations, and the mass 
conservation is governed by the continuity equation. Turbulence effects are modeled 
using Wilcox revised two-equation k-ω model with realizability constraints. Flow close 
to walls is modeled using wall functions.

There are two study types available for this physics interface. Using the Time Dependent 
study type, the rotation is achieved through moving mesh functionality, also known as 
sliding mesh. Using the Frozen Rotor study type, the rotating parts are kept frozen in 
position, and the rotation is accounted for by the inclusion of centrifugal and Coriolis 
forces. See Theory for the Rotating Machinery Interfaces in the CFD Module User’s 
Guide.

When this physics interface is added, the following physics nodes are also added in the 
Model Builder under Turbulent Flow, k-ω — Fluid Properties, Wall and Initial Values. A 
Moving Mesh interface with a Rotating Domain node is added automatically in the Model 

Builder under the Definitions node. Then, from the Physics toolbar, add other nodes 
that implement, for example, boundary conditions and volume forces. You can also 
right-click Turbulent Flow, k-ω to select physics features from the context menu. For 
information about the available physics features, see Domain, Boundary, Point, and 
Pair Nodes for the Rotating Machinery Interfaces.

A part for the settings defined below, see the advanced settings for The Rotating 
Machinery, Laminar Flow Interface, and the settings in The Creeping Flow, Laminar 
Flow, Turbulent Flow, and Large Eddy Simulation Interfaces in the CFD Module 
User’s Guide. 

T U R B U L E N C E  M O D E L  P A R A M E T E R S

Turbulence model parameters are optimized to fit as many flow types as possible, but 
for some special cases, better performance can be obtained by tuning the model 
parameters.

For this physics interface the parameters are α, σk
∗, σw, β0, β0

∗, κv, and B.
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D E P E N D E N T  V A R I A B L E S

The following dependent variables (fields) are defined for this physics interface:

• Velocity field u and its components 

• Pressure p

• Turbulent kinetic energy k

• Specific dissipation rate om

The Rotating Machinery, Turbulent Flow, SST Interface

The Rotating Machinery, Turbulent Flow, SST (spf) interface ( ), found under the 
Single-Phase Flow>Rotating Machinery branch ( ) when adding a physics interface, is 
used to simulate flow at high Reynolds numbers in geometries with one or more 
rotating parts. The physics interface supports incompressible, weakly compressible and 
compressible flows at low Mach numbers (typically less than 0.3). The physics interface 
is available for 3D and 2D components.

The momentum balance is governed by the Navier-Stokes equations, and the mass 
conservation is governed by the continuity equation. Turbulence effects are modeled 
using the SST two-equation model with realizability constraints. The SST model is a 
so-called low-Reynolds number model, which means that it resolves the flow all the 
way down to the wall. The SST model depends on the distance to the closest wall. The 
physics interface therefore includes a wall distance equation.

There are two study types available for this physics interface. Using the Time Dependent 

with Initialization study type, the rotation is achieved through moving mesh 
functionality, also known as sliding mesh. Using the Frozen Rotor with Initialization 
study type, the rotating parts are kept frozen in position, and the rotation is accounted 
for by the inclusion of centrifugal and Coriolis forces. See Theory for the Rotating 
Machinery Interfaces in the CFD Module User’s Guide. In both study types 
initialization is performed by first solving for the distance to the closest wall.

When this physics interface is added, the following physics nodes are also added in the 
Model Builder under Turbulent Flow, SST — Fluid Properties, Wall and Initial Values. A 
Moving Mesh interface with a Rotating Domain node is added automatically in the Model 

Builder under the Definitions node. Then, from the Physics toolbar, add other nodes 
that implement, for example, boundary conditions and volume forces. You can also 
right-click Turbulent Flow, SST to select physics features from the context menu. For 
information about the available physics features, see Domain, Boundary, Point, and 
Pair Nodes for the Rotating Machinery Interfaces.
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A part for the interface settings defined below, see the advanced settings for The 
Rotating Machinery, Laminar Flow Interface, and the settings in The Creeping Flow, 
Laminar Flow, Turbulent Flow, and Large Eddy Simulation Interfaces in the CFD 
Module User’s Guide.

T U R B U L E N C E  M O D E L  P A R A M E T E R S

Turbulence model parameters are optimized to fit as many flow types as possible, but 
for some special cases, better performance can be obtained by tuning the model 
parameters. For this physics interface the parameters are a1, β0

∗, β1, β2, γ1, γ2, σk1, σk2, 
σw1,and σw2.

D E P E N D E N T  V A R I A B L E S

The following dependent variables (fields) are defined for this physics interface:

• Velocity field u and its components

• Pressure p

• Turbulent kinetic energy k

• Specific dissipation rate om

• Reciprocal wall distance G

The Rotating Machinery, Turbulent Flow, Low Re k-ε Interface

The Rotating Machinery, Turbulent Flow, Low Re k-ε (spf) interface ( ), found under 
the Single-Phase Flow>Rotating Machinery branch ( ) when adding a physics interface, 
is used to simulate flow at high Reynolds numbers in geometries with one or more 
rotating parts. The physics interface supports incompressible, weakly compressible and 
compressible flows at low Mach numbers (typically less than 0.3). The physics interface 
is available for 3D and 2D components.

The momentum balance is governed by the Navier-Stokes equations, and the mass 
conservation is governed by the continuity equation. Turbulence effects are modeled 
using the AKN two-equation k-ε model with realizability constraints. The AKN model 
is a so-called low-Reynolds number model, which means that it resolves the flow all the 
way down to the wall. The AKN model depends on the distance to the closest wall. 
The physics interface therefore includes a wall distance equation.

There are two study types available for this physics interface. Using the Time Dependent 

with Initialization study type, the rotation is achieved through moving mesh 
functionality, also known as sliding mesh. Using the Frozen Rotor with Initialization 
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study type, the rotating parts are kept frozen in position, and the rotation is accounted 
for by the inclusion of centrifugal and Coriolis forces. See Theory for the Rotating 
Machinery Interfaces in the CFD Module User’s Guide. In both study types 
initialization is performed by first solving for the distance to the closest wall.

When this physics interface is added, the following physics nodes are also added in the 
Model Builder under Turbulent Flow, Low Re k-ε— Fluid Properties, Wall and Initial 

Values. A Moving Mesh interface with a Rotating Domain node is added automatically in 
the Model Builder under the Definitions node. Then, from the Physics toolbar, add other 
nodes that implement, for example, boundary conditions and volume forces. You can 
also right-click Turbulent Flow, Low Re k-ε to select physics features from the context 
menu. For information about the available physics features, see Domain, Boundary, 
Point, and Pair Nodes for the Rotating Machinery Interfaces.

A part for the interface settings defined below, see the advanced settings defined for 
The Rotating Machinery, Laminar Flow Interface, and the settings in The Creeping 
Flow, Laminar Flow, Turbulent Flow, and Large Eddy Simulation Interfaces in the 
CFD Module User’s Guide.

T U R B U L E N C E  M O D E L  P A R A M E T E R S

Turbulence model parameters are optimized to fit as many flow types as possible, but 
for some special cases, better performance can be obtained by tuning the model 
parameters.

For this physics interface the parameters are Ce1, Ce2, Cμ, σk, σe, and κv.

D E P E N D E N T  V A R I A B L E S

The following dependent variables (fields) are defined for this physics interface:

• Velocity field u and its components

• Pressure p

• Turbulent kinetic energy k

• Turbulent dissipation rate ep

• Reciprocal wall distance G

The Rotating Machinery, Turbulent Flow, Spalart-Allmaras 
Interface

The Rotating Machinery, Turbulent Flow, Spalart-Allmaras (spf) interface ( ), found 
under the Single-Phase Flow>Rotating Machinery branch ( ) when adding a physics 
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interface, is used to simulate flow at high Reynolds numbers in geometries with one or 
more rotating parts. The physics interface supports incompressible, weakly 
compressible and compressible flows at low Mach numbers (typically less than 0.3). 
The physics interface is available for 3D and 2D components.

The momentum balance is governed by the Navier-Stokes equations, and the mass 
conservation is governed by the continuity equation. Turbulence effects are modeled 
using the Spalart-Allmaras one-equation model. The Spalart-Allmaras model is a 
so-called low-Reynolds number model, which means that it resolves the flow all the 
way down to the wall. The Spalart-Allmaras model depends on the distance to the 
closest wall. The physics interface therefore includes a wall distance equation.

There are two study types available for this physics interface. Using the Time Dependent 

with Initialization study type, the rotation is achieved through moving mesh 
functionality, also known as sliding mesh. Using the Frozen Rotor with Initialization 
study type, the rotating parts are kept frozen in position, and the rotation is accounted 
for by the inclusion of centrifugal and Coriolis forces. See Theory for the Rotating 
Machinery Interfaces in the CFD Module User’s Guide. In both study types 
initialization is performed by first solving for the distance to the closest wall.

When this physics interface is added, the following physics nodes are also added in the 
Model Builder under Turbulent Flow, Spalart-Allmaras — Fluid Properties, Wall, and Initial 

Values. A Moving Mesh interface with a Rotating Domain node is added automatically in 
the Model Builder under the Definitions node. Then, from the Physics toolbar, add other 
nodes that implement, for example, boundary conditions and volume forces. You can 
also right-click Turbulent Flow, Spalart-Allmaras to select physics features from the 
context menu. For information about the available physics features, see Domain, 
Boundary, Point, and Pair Nodes for the Rotating Machinery Interfaces.

A part for the interface settings defined below, see the advanced settings defined for 
The Rotating Machinery, Laminar Flow Interface, and the settings in The Creeping 
Flow, Laminar Flow, Turbulent Flow, and Large Eddy Simulation Interfaces in the 
CFD Module User’s Guide.

T U R B U L E N C E  M O D E L  P A R A M E T E R S

Turbulence model parameters are optimized to fit as many flow types as possible, but 
for some special cases, better performance can be obtained by tuning the model 
parameters.

For this physics interface the parameters are Cb1, Cb2, Cv1, σv, Cw2, Cw3, κv, and Crot.
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A D V A N C E D  S E T T I N G S

To display this section, click the Show button ( ) and select Advanced Physics Options. 
Under the Turbulence variables scale parameters subsection, the default νscale is of the 
same order of magnitude as the kinematic viscosity of air at room temperature. 

D E P E N D E N T  V A R I A B L E S

The following dependent variables (fields) are defined for this physics interface:

• Velocity field u and its components 

• Pressure p

• Reciprocal wall distance G

• Undamped turbulent kinematic viscosity nutilde

The Rotating Machinery, Turbulent Flow, v2-f Interface

The Rotating Machinery, Turbulent Flow, v2-f (spf) interface ( ), found under the 
Single-Phase Flow>Rotating Machinery branch ( ) when adding a physics interface, is 
used to simulate flow at high Reynolds numbers in geometries with one or more 
rotating parts. The physics interface supports incompressible, weakly compressible, 
weakly compressible and compressible flows at low Mach numbers (typically less than 
0.3). The physics interface is available for 3D and 2D components.

The momentum balance is governed by the Navier-Stokes equations, and the mass 
conservation is governed by the continuity equation. Turbulence effects are modeled 
using the v2-f transport-equation model with realizability constraints. The v2-f model 
is a so-called low-Reynolds number model, which means that it can resolve the flow all 
the way down to the wall. The physics interface includes a wall distance equation.

There are two study types available for this physics interface. Using the Time Dependent 

with Initialization study type, the rotation is achieved through moving mesh 
functionality, also known as sliding mesh. Using the Frozen Rotor with Initialization 
study type, the rotating parts are kept frozen in position, and the rotation is accounted 
for by the inclusion of centrifugal and Coriolis forces. See Theory for the Rotating 
Machinery Interfaces in the CFD Module User’s Guide. In both study types 
initialization is performed by first solving for the distance to the closest wall.

When this physics interface is added, the following physics nodes are also added in the 
Model Builder under Turbulent Flow, v2-f — Fluid Properties, Wall and Initial Values. A 
Moving Mesh interface with a Rotating Domain node is added automatically in the Model 

Builder under the Definitions node. Then, from the Physics toolbar, add other nodes 
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that implement, for example, boundary conditions and volume forces. You can also 
right-click Turbulent Flow, v2-f to select physics features from the context menu. For 
information about the available physics features, see Domain, Boundary, Point, and 
Pair Nodes for the Rotating Machinery Interfaces.

A part for the interface settings defined below, see the advanced settings defined for 
The Rotating Machinery, Laminar Flow Interface, and the settings in The Creeping 
Flow, Laminar Flow, Turbulent Flow, and Large Eddy Simulation Interfaces in the 
CFD Module User’s Guide.

T U R B U L E N C E  M O D E L  P A R A M E T E R S

Turbulence model parameters are optimized to fit as many flow types as possible, but 
for some special cases, better performance can be obtained by tuning the model 
parameters.

For this physics interface the parameters are Cμv2f, Cτ, Cη, CL, C1, C2, Cε1v2f, Cε2v2f, 
A1, σkv2f, σεv2f, σζv2f, κv, and B.

D E P E N D E N T  V A R I A B L E S

The following dependent variables (fields) are defined for this physics interface:

• Velocity field u and its components

• Pressure p

• Turbulent kinetic energy k

• Turbulent dissipation rate ep

• Turbulent relative fluctuations zeta

• Elliptic blending function alpha

• Reciprocal wall distance G
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Domain, Boundary, Point, and Pair Nodes for the Rotating 
Machinery Interfaces

All versions of the Rotating Machinery, Fluid Flow interfaces use the following 
domain, boundary, point, and pair physics nodes.

The nodes are available under the option Rotating Machinery from the Physics ribbon 
toolbar (Windows users), Physics context menu (Mac or Linux users), or right-click to 
access the context menu (all users).

The following nodes, available in the Fluid Flow interfaces, are described for the 
Laminar Flow interface in the CFD Module User’s Guide:

• Contact Angle

• Free Surface

• Rotating Shaft

• Stationary Free Surface

• Initial Values

• Wall

• Interior Wall

• No Viscous Stress

• Flow Continuity

• Fluid Properties

• Inlet

• Line Mass Source

• Open Boundary

• Outlet

• Periodic Flow Condition

• Point Mass Source

• Pressure Point Constraint

• Screen

• Symmetry

• Volume Force

References for the Single-Phase Flow, Turbulent Flow Interfaces
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Stationary Free Surface

This postprocessing feature is used to estimate the deformation of a free surface from 
the pressure distribution on the boundary when using the Frozen Rotor or Frozen Rotor 

with Initialization study types. When computing the flow field, a slip condition together 
with a constant pressure level pext is applied on the boundary. The free surface 
deformation ηFS is evaluated from the linearized free surface condition in a separate 
study step, Stationary Free Surface, using the pressure from the Frozen Rotor study 
step.

 (5-1)

σ is the surface tension coefficient, x = x0 represents the position of the undisturbed 
surface - the feature selection, and  is its unit normal. The correct study sequence 
can be triggered by toggling the study window once a selection for the Stationary Free 
Surface feature has been made.

The Stationary Free Surface feature is supported by laminar and turbulent flow, and is 
applicable for small surface deformations (ηFS and its gradient should be small 
compared to the dimensions of the computational domain). If the surface deformation 
is large, a time-dependent study with a Deforming Domain and a Free Surface feature 
should be used instead.

Iterative solvers are necessary to reduce the cost of models with large number of 
degrees of freedom. The fluid flow interfaces use a Smoothed aggregation AMG solver 
per default. It is recommendable to switch to a Geometric multigrid solver when 
working with the Stationary Free Surface feature to ensure robustness of the model.

S T A T I O N A R Y  F R E E  S U R F A C E

Enter an External pressure pext corresponding to the average pressure level on the free 
surface.

p x0( ) pext– n̂ p
x x0=

ηFS∇⋅+ σ∇S
2ηFS–=

n̂

The Choice of Solver and Solver Settings in the CFD Module User’s 
Guide and Studies and Solvers in the COMSOL Multiphysics Reference 
Manual
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S U R F A C E  T E N S I O N

The Surface tension coefficient σ (SI unit: N/m) can be specified from predefined 
libraries, by selecting Library coefficient, liquid/gas interface (the default) or Library 

coefficient, liquid/liquid interface, or be set to User defined.

• For Library coefficient, liquid/gas interface select an option from the list — Water/Air 
(the default), Acetone/Air, Acetic acid/Air, Ethanol/Air, Ethylene glycol/Ethylene glycol 

vapor, Diethyl ether/Air, Glycerol/Air, Heptane/Nitrogen, Mercury/Mercury vapor, or 
Toluene/Air.

• For Library coefficient, liquid/liquid interface select an option from the list — 
Benzene/Water, 20°C, Corn oil/Water, 20°C, Ether/Water, 20°C, Hexane/Water, 20°C, 
Mercury/Water, 20°C, or Olive oil/Water, 20°C.

Only one Stationary Free Surface feature can be applied in a Rotating Machinery, Fluid 
Flow interface, and it requires the study to be stationary (Frozen Rotor).

L O C A T I O N  I N  U S E R  I N T E R F A C E

Right click the physics interface and select Rotating Machinery>Stationary Free Surface

Ribbon
Physics tab with the physics interface selected:

Boundaries>Rotating Machinery>Stationary Free Surface

Free Surface

This feature is used to define the two-phase interface separating the modeled fluid in 
a free surface domain from the outer fluid. By applying this boundary condition the 
motion of the two-phase interface can be tracked. The free surface follows the fluid 
motion in the normal direction. In the tangential direction the free surface motion is 
governed by the fluid motion in combination with the surface tension of the fluid-fluid 
interface.

The Free Surface node can only be applied to outer boundaries of a Deforming Domain 
that do not have any boundary condition assigned under Moving Mesh.

To control the attachment angle between the free surface and adjacent walls, a Contact 
Angle node is by default added under the Free Surface node.

The Free Surface feature is supported by laminar flow and by turbulence models using 
wall functions or automatic wall treatment but not low-Reynolds number wall 
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treatment. It also requires the study to be time dependent. The node is inactive for 
Frozen Rotor studies.

F R E E  S U R F A C E

Enter an External pressure pext (SI unit: Pa) corresponding to the pressure level in the 
external fluid phase.

S U R F A C E  T E N S I O N

The Surface tension coefficient σ (SI unit: N/m) can be specified from predefined 
libraries, by selecting Library coefficient, liquid/gas interface (the default) or Library 

coefficient, liquid/liquid interface, or set to User defined.

• For Library coefficient, liquid/gas interface select an option from the list — Water/Air 
(the default), Acetone/Air, Acetic acid/Air, Ethanol/Air, Ethylene glycol/Ethylene glycol 

vapor, Diethyl ether/Air, Glycerol/Air, Heptane/Nitrogen, Mercury/Mercury vapor, or 
Toluene/Air.

• For Library coefficient, liquid/liquid interface select an option from the list — 
Benzene/Water, 20°C, Corn oil/Water, 20°C, Ether/Water, 20°C, Hexane/Water, 20°C, 
Mercury/Water, 20°C, or Olive oil/Water, 20°C.

L O C A T I O N  I N  U S E R  I N T E R F A C E

Context Menus
Right click the physics interface and select Rotating Machinery>Free Surface

Ribbon
Physics tab with the physics interface selected:

Boundaries>Rotating Machinery>Free Surface

The Free Surface feature imposes a mesh deformation in the normal 
direction. On adjacent boundaries, the mesh displacement parallel to 
those boundaries cannot be fixed if the contact point is moving. In this 
case a Mesh Slip, Symmetry/Roller, Prescribed Normal Mesh 
Displacement, or Prescribed Normal Mesh Velocity boundary condition 
under Moving Mesh should be selected. A Mesh Slip condition is 
automatically used on boundaries that are adjacent to the Free Surface 
and dot not have a prescribed Moving Mesh boundary condition.
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Contact Angle 

This feature specifies the contact angle between the free surface and a solid wall. The 
Contact Angle feature is a subfeature to, and added under a Stationary Free Surface or 
a Free Surface feature.

C O N T A C T  A N G L E

Select an option from the Specify contact angle list — Directly (the default) or Through 

Young’s equation.

• For Directly enter a Contact angle θw (SI unit: rad). The default is π/2.

• For Through Young’s equation enter values or expressions for Phase 1-Solid surface 

energy density γs1 (SI unit: J/m2) and Phase 2-Solid surface energy density γs2 (SI 
unit: J/m2).

The remainder of this section applies when the Contact Angle feature is a subfeature 
to the Free Surface feature.

The condition applies forces on the wall that balance the surface tension for the 
prescribed contact angle. For laminar flow, the Contact Angle node should be used on 
edges or points where a Wall feature with the Navier Slip option is prescribed adjacent 
to the free surface. In this case, the Navier Slip option is required for the contact line 
to move along the wall.

The representation of the contact angle is dependent on the mesh resolution in the 
region where the fluid-fluid interface attaches to the wall. If, during the simulation, the 
contact angle is found to fluctuate around a given value, this indicates that the 
resolution needs to be improved. This can for example be achieved by adding more 
mesh boundary layers on the wall.

If a Free Surface feature is in contact with a solid boundary, the movement 
of the contact point is not compatible with the no slip condition. For 
laminar flow the Wall feature with the Navier Slip option should be 
selected. For turbulence models with wall functions or automatic wall 
treatment the Wall feature with the No Slip option can be selected.

The moving mesh boundary condition must be compatible with the 
motion of the wall for the problem to have a valid solution.
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Rotating Shaft

This boundary feature specifies flow conditions on boundaries where the fluid is 
subjected to a solid shaft rotation. This feature can be applied to rotating shaft 
boundaries in a free-surface domain modeled by a Deforming Domain that connects to 
a rotating shaft in a Rotating Domain.

The flow condition prescribed by the feature corresponds to a rotational velocity 
defined from an existing Rotating Domain. In order for the contact line, defined by 
intersection of the rotating shaft and the free surface, to be able to move along the 
rotating shaft the velocity condition is applied using a Wall boundary condition with 
the Navier Slip option for laminar flow. For turbulent flow, wall functions or automatic 
wall treatment must be applied.

R O T A T I N G  S H A F T

Axis of Rotation
Select the Axis of rotation. If x-axis is selected, this corresponds to a rotational axis 
(1, 0, 0) with the origin as the base point. Correspondingly, if y-axis or z-axis is 
selected, the rotational axis is defined by a unit vector in the selected direction together 
with a base point at the origin. For User defined enter values into these fields: Rotation 

axis base point and Rotation axis direction. The z-axis is the default choice and the 
default values in the fields for User defined correspond to those for the z-axis.

Angular Velocity
Select the rotating shaft Rotational frequency from the list:

• Select the Revolution per time option to manually define the rotational velocity (SI 
unit: rad/s) and select the Rotational direction as Positive angular velocity or Negative 

angular velocity. This is the default setting.

• Select the Angular velocity option to manually define the angular velocity (SI unit: 
rad/s).

L O C A T I O N  I N  U S E R  I N T E R F A C E

Context Menus
Right click the physics interface and select Rotating Machinery>Rotating Shaft

Ribbon
Physics tab with the physics interface selected:

Boundaries>Rotating Machinery>Rotating Shaft
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R o t a t i n g  M a c h i n e r y ,
M u l t i p h a s e F l o w I n t e r f a c e s
This chapter describes the physics interfaces found under the Fluid Flow>Multiphase 

Flow>Rotating Machinery, Multiphase Flow branch ( ). In this chapter:

• The Rotating Machinery, Mixture Model, Laminar Flow Interface

• The Rotating Machinery, Mixture Model, Algebraic yPlus Interface

• The Rotating Machinery, Mixture Model, L-VEL Interface

• The Rotating Machinery, Mixture Model, k-ε Interface

• The Rotating Machinery, Mixture Model, Realizable k-ε Interface

• The Rotating Machinery, Mixture Model, k-ω Interface

• The Rotating Machinery, Mixture Model, SST Interface

• The Rotating Machinery, Mixture Model, Low Re k-ε Interface

• The Rotating Machinery, Mixture Model, Spalart-Allmaras Interface

• The Rotating Machinery, Mixture Model, v2-f Interface

• Domain, Boundary, Pair, and Point Nodes for the Rotating Machinery, Mixture 
Model Interfaces
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Th e  Ro t a t i n g  Ma ch i n e r y ,  Mu l t i p h a s e  
F l ow ,  M i x t u r e  Mode l ,  L am i n a r  F l ow 
and Tu r bu l e n t  F l ow I n t e r f a c e s

The Rotating Machinery, Mixture Model, Laminar Flow Interface

The Laminar Flow version of the Rotating Machinery, Mixture Model (mm) interface ( ) 
is used to model low to moderate Reynolds number flow of a multiphase mixture in 
equipment containing one or more rotating parts. The mixture consists of a liquid with 
dispersed particles, bubbles, liquid droplets, or solid particles, which are assumed to 
always travel with terminal velocity.

The interface solves one set of Navier-Stokes equations for the momentum of the 
mixture. The pressure distribution is calculated from a mixture-averaged continuity 
equation and the velocity of the dispersed phase is described by a slip model. The 
dispersed particles are tracked by solving a transport equation for the volume fraction 
of the dispersed phase. The physics interface can also model the distribution of the 
number density, which in turn can be used to calculate the interfacial area, useful when 
simulating chemical reactions in the mixture.

There are two study types available for this physics interface. For the Time Dependent 

study type the rotation is achieved by moving mesh functionality, also known as sliding 
mesh. For the Frozen Rotor study type the rotating parts are kept frozen in position, 
and the rotation is accounted for by the inclusion of centrifugal and Coriolis forces.

When this physics interface is added, the following default nodes are also added in the 
Model Builder under Mixture Model, Laminar Flow — Mixture Properties, Wall, and Initial 

Values. A Moving Mesh interface with a Rotating Domain node is added automatically in 
the Model Builder under the Definitions node. Then, from the Physics toolbar, add other 
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nodes that implement, for example, boundary conditions. You can also right-click 
Mixture Model, Laminar Flow to select physics features from the context menu.

S E T T I N G S

The Label is the default physics interface name. 

The Name is used primarily as a scope prefix for variables defined by the physics 
interface. Refer to such physics interface variables in expressions using the pattern 
<name>.<variable_name>. In order to distinguish between variables belonging to 
different physics interfaces, the name string must be unique. Only letters, numbers, and 
underscores (_) are permitted in the Name field. The first character must be a letter.

The default Name (for the first physics interface in the model) is mm.

Most of the physics interface settings are the same as described for The Mixture Model, 
Laminar Flow Interface in the CFD Module User’s Guide, and for Moving Mesh. 
Only unique settings are discussed below.

A D V A N C E D  S E T T I N G S

To display this section, click the Show button ( ) and select Advanced Physics Options. 
Normally these settings do not need to be changed.

Pseudo Time Stepping
Select the Use pseudo time stepping for stationary equation form check box to add 
pseudo time derivatives to the equation when the Frozen Rotor equation form is used. 
(Frozen rotor is a pseudo stationary formulation.) When selected, also choose a CFL 

number expression—Automatic (the default) or Manual. Automatic sets the local CFL 
number (from the Courant–Friedrichs–Lewy condition) to the built-in variable 

In previous versions of COMSOL Multiphysics (prior to version 5.4), a 
specific physics interface called Rotating Machinery, Mixture Model (rmmf) 

was added to the Model Builder. Now, a predefined multiphysics coupling 
approach is used, improving the flexibility and design options for your 
modeling. For specific details, see The Multiphysics Branch and 
Multiphysics Modeling Approaches in the COMSOL Multiphysics 
Reference Manual.
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CFLCMP which in turn triggers a PID regulator for the CFL number. For Manual enter 
a Local CFL number CFLloc (dimensionless).

D E P E N D E N T  V A R I A B L E S

Enter values for the dependent variables (field variables):

• Velocity field, mixture u (SI unit: m/s)

• Pressure p (SI unit: Pa)

• Volume fraction, dispersed phase phid (dimensionless)

• Squared slip velocity slipvel 

• Number density, dispersed phase nd (SI unit: 1/m3) 

The names can be changed, but the names of fields and dependent variables must be 
unique within a component.

The Rotating Machinery, Mixture Model, Algebraic yPlus Interface

The Rotating Machinery, Mixture Model, Algebraic yPlus (mm) interface ( ) is used to 
model high Reynolds number flow of a multiphase mixture in equipment containing 
one or more rotating parts. The mixture consists of a liquid with dispersed particles, 
bubbles, liquid droplets, or solid particles, which are assumed to always travel with 
terminal velocity.

The interface solves one set of Navier-Stokes equations for the momentum of the 
mixture. The pressure distribution is calculated from a mixture-averaged continuity 
equation and the velocity of the dispersed phase is described by a slip model. The 
dispersed particles are tracked by solving a transport equation for the volume fraction 
of the dispersed phase. Turbulence effects are included using and enhanced viscosity 
model based on the scaled wall distance, and the physics interface therefore includes a 
wall distance equation.

The physics interface can also model the distribution of the number density, which in 
turn can be used to calculate the interfacial area, useful when simulating chemical 
reactions in the mixture.

There are two study types available for this physics interface. Using the Time Dependent 

with Initialization study type, the rotation is achieved through moving mesh 

Pseudo Time Stepping for Laminar Flow Models in the CFD Module 
User’s Guide
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functionality, also known as sliding mesh. Using the Frozen Rotor with Initialization 

study type, the rotating parts are kept frozen in position, and the rotation is accounted 
for by the inclusion of centrifugal and Coriolis forces. All study types include an initial 
Wall Distance Initialization step in order to compute the wall distance. See Theory for 
the Rotating Machinery Interfaces in the CFD Module User’s Guide.

When this physics interface is added, the following default nodes are also added in the 
Model Builder, under Mixture Model, Algebraic yPlus — Mixture Properties, Wall, and 
Initial Values. A Moving Mesh interface with a Rotating Domain node is added 
automatically in the Model Builder under the Definitions node. Then, from the Physics 
toolbar, add other nodes that implement, for example, boundary conditions. You can 
also right-click Mixture Model, Algebraic yPlus to select physics features from the context 
menu.

The physics interface settings are the same as described for The Rotating Machinery, 
Mixture Model, Laminar Flow Interface, for Moving Mesh, and for the The Mixture 
Model, Algebraic yPlus Interface in the CFD Module User’s Guide.

The Rotating Machinery, Mixture Model, L-VEL Interface

The Rotating Machinery, Mixture Model, L-VEL (mm) interface ( ) is used to model 
high Reynolds number flow of a multiphase mixture in equipment containing one or 
more rotating parts. The mixture consists of a liquid with dispersed particles, bubbles, 
liquid droplets, or solid particles, which are assumed to always travel with terminal 
velocity.

The interface solves one set of Navier-Stokes equations for the momentum of the 
mixture. The pressure distribution is calculated from a mixture-averaged continuity 
equation and the velocity of the dispersed phase is described by a slip model. The 
dispersed particles are tracked by solving a transport equation for the volume fraction 
of the dispersed phase. Turbulence effects are included using and enhanced viscosity 
model based on the local wall distance, and the physics interface therefore includes a 
wall distance equation.

The physics interface can also model the distribution of the number density, which in 
turn can be used to calculate the interfacial area, useful when simulating chemical 
reactions in the mixture.

There are two study types available for this physics interface. Using the Time Dependent 

with Initialization study type, the rotation is achieved through moving mesh 
functionality, also known as sliding mesh. Using the Frozen Rotor with Initialization 
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study type, the rotating parts are kept frozen in position, and the rotation is accounted 
for by the inclusion of centrifugal and Coriolis forces. All study types include an initial 
Wall Distance Initialization step in order to compute the wall distance. See Theory for 
the Rotating Machinery Interfaces in the CFD Module User’s Guide.

When this physics interface is added, the following default nodes are also added in the 
Model Builder, under Mixture Model, L-VEL — Mixture Properties, Wall, and Initial Values. 
A Moving Mesh interface with a Rotating Domain node is added automatically in the 
Model Builder under the Definitions node. Then, from the Physics toolbar, add other 
nodes that implement, for example, boundary conditions. You can also right-click 
Mixture Model, L-VEL to select physics features from the context menu.

The physics interface settings are the same as described for The Rotating Machinery, 
Mixture Model, Laminar Flow Interface, for Moving Mesh, and for the The Mixture 
Model, L-VEL Interface in the CFD Module User’s Guide.

The Rotating Machinery, Mixture Model, k-ε Interface

The Rotating Machinery, Mixture Model, k-ε (mm) interface ( ) is used to model high 
Reynolds number flow of a multiphase mixture in equipment containing one or more 
rotating parts. The mixture consists of a liquid with dispersed particles, bubbles, liquid 
droplets, or solid particles, which are assumed to always travel with terminal velocity.

The interface solves one set of Navier-Stokes equations for the momentum of the 
mixture. The pressure distribution is calculated from a mixture-averaged continuity 
equation and the velocity of the dispersed phase is described by a slip model. The 
dispersed particles are tracked by solving a transport equation for the volume fraction 
of the dispersed phase. Turbulence effects are modeled using the standard 
two-equation k-ε model with realizability constraints. Flow close to walls is modeled 
using wall functions.

The physics interface can also model the distribution of the number density, which in 
turn can be used to calculate the interfacial area, useful when simulating chemical 
reactions in the mixture.

There are two study types available for this physics interface. For the Time Dependent 

study type the rotation is achieved by moving mesh functionality, also known as sliding 
mesh. For the Frozen Rotor study type the rotating parts are kept frozen in position, 
and the rotation is accounted for by the inclusion of centrifugal and Coriolis forces.

When this physics interface is added, the following default nodes are also added in the 
Model Builder, under Mixture Model, k-ε — Mixture Properties, Wall, and Initial Values. 
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A Moving Mesh interface with a Rotating Domain node is added automatically in the 
Model Builder under the Definitions node. Then, from the Physics toolbar, add other 
nodes that implement, for example, boundary conditions. You can also right-click 
Mixture Model, k-ε to select physics features from the context menu.

The physics interface settings are the same as described for The Rotating Machinery, 
Mixture Model, Laminar Flow Interface, for Moving Mesh, and for the The Mixture 
Model, k-ε Interface in the CFD Module User’s Guide.

The Rotating Machinery, Mixture Model, Realizable k-ε Interface

The Rotating Machinery, Mixture Model, Realizable k-ε (mm) interface ( ) is used to 
model high Reynolds number flow of a multiphase mixture in equipment containing 
one or more rotating parts. The mixture consists of a liquid with dispersed particles, 
bubbles, liquid droplets, or solid particles, which are assumed to always travel with 
terminal velocity.

The interface solves one set of Navier-Stokes equations for the momentum of the 
mixture. The pressure distribution is calculated from a mixture-averaged continuity 
equation and the velocity of the dispersed phase is described by a slip model. The 
dispersed particles are tracked by solving a transport equation for the volume fraction 
of the dispersed phase. Turbulence effects are modeled using the realizable 
two-equation k-ε model. Flow close to walls is modeled using wall functions.

The physics interface can also model the distribution of the number density, which in 
turn can be used to calculate the interfacial area, useful when simulating chemical 
reactions in the mixture.

There are two study types available for this physics interface. For the Time Dependent 

study type the rotation is achieved by moving mesh functionality, also known as sliding 
mesh. For the Frozen Rotor study type the rotating parts are kept frozen in position, 
and the rotation is accounted for by the inclusion of centrifugal and Coriolis forces.

In previous versions of COMSOL Multiphysics (prior to version 5.4), a 
specific physics interface called Rotating Machinery, Mixture Model (rmmf) 

was added to the Model Builder. Now, a predefined multiphysics coupling 
approach is used, improving the flexibility and design options for your 
modeling. For specific details, see The Multiphysics Branch and 
Multiphysics Modeling Approaches in the COMSOL Multiphysics 
Reference Manual.
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When this physics interface is added, the following default nodes are also added in the 
Model Builder, under Mixture Model, Realizable k-ε — Mixture Properties, Wall, and Initial 

Values. A Moving Mesh interface with a Rotating Domain node is added automatically in 
the Model Builder under the Definitions node. Then, from the Physics toolbar, add other 
nodes that implement, for example, boundary conditions. You can also right-click 
Mixture Model, Realizable k-ε to select physics features from the context menu.

The physics interface settings are the same as described for The Rotating Machinery, 
Mixture Model, Laminar Flow Interface, for Moving Mesh, and for the The Mixture 
Model, Realizable k-ε Interface in the CFD Module User’s Guide.

The Rotating Machinery, Mixture Model, k-ω Interface

The Rotating Machinery, Mixture Model, k-ω (mm) interface ( ) is used to model high 
Reynolds number flow of a multiphase mixture in equipment containing one or more 
rotating parts. The mixture consists of a liquid with dispersed particles, bubbles, liquid 
droplets, or solid particles, which are assumed to always travel with terminal velocity.

The interface solves one set of Navier-Stokes equations for the momentum of the 
mixture. The pressure distribution is calculated from a mixture-averaged continuity 
equation and the velocity of the dispersed phase is described by a slip model. The 
dispersed particles are tracked by solving a transport equation for the volume fraction 
of the dispersed phase. Turbulence effects are modeled using the Wilcox revised 
two-equation k-ω model with realizability constraints. The k-ω model is a so-called 
low-Reynolds-number model, which means that it can resolve the flow all the way 
down to the wall.

The physics interface can also model the distribution of the number density, which in 
turn can be used to calculate the interfacial area, useful when simulating chemical 
reactions in the mixture.

There are two study types available for this physics interface. For the Time Dependent 

study type the rotation is achieved by moving mesh functionality, also known as sliding 
mesh. For the Frozen Rotor study type the rotating parts are kept frozen in position, 
and the rotation is accounted for by the inclusion of centrifugal and Coriolis forces.

When this physics interface is added, the following default nodes are also added in the 
Model Builder, under Mixture Model, k-ω — Mixture Properties, Wall, and Initial Values. 
A Moving Mesh interface with a Rotating Domain node is added automatically in the 
Model Builder under the Definitions node. Then, from the Physics toolbar, add other 
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nodes that implement, for example, boundary conditions. You can also right-click 
Mixture Model, k-ω to select physics features from the context menu.

The physics interface settings are the same as described for The Rotating Machinery, 
Mixture Model, Laminar Flow Interface, for Moving Mesh, and for the The Mixture 
Model, k-ω Interface in the CFD Module User’s Guide.

The Rotating Machinery, Mixture Model, SST Interface

The Rotating Machinery, Mixture Model, SST (mm) interface ( ) is used to model high 
Reynolds number flow of a multiphase mixture in equipment containing one or more 
rotating parts. The mixture consists of a liquid with dispersed particles, bubbles, liquid 
droplets, or solid particles, which are assumed to always travel with terminal velocity.

The interface solves one set of Navier-Stokes equations for the momentum of the 
mixture. The pressure distribution is calculated from a mixture-averaged continuity 
equation and the velocity of the dispersed phase is described by a slip model. The 
dispersed particles are tracked by solving a transport equation for the volume fraction 
of the dispersed phase. Turbulence effects are modeled using the Menter shear-stress 
transport (SST) two-equation model from 2003 with realizability constraints. The SST 
model is a so-called low-Reynolds-number model, which means that it can resolve the 
flow all the way down to the wall. The SST model depends on the distance to the 
closest wall. The physics interface therefore includes a wall distance equation.

The physics interface can also model the distribution of the number density, which in 
turn can be used to calculate the interfacial area, useful when simulating chemical 
reactions in the mixture.

There are two study types available for this physics interface. Using the Time Dependent 

with Initialization study type, the rotation is achieved through moving mesh 
functionality, also known as sliding mesh. Using the Frozen Rotor with Initialization 

study type, the rotating parts are kept frozen in position, and the rotation is accounted 
for by the inclusion of centrifugal and Coriolis forces. All study types include an initial 
Wall Distance Initialization step in order to compute the wall distance. See Theory for 
the Rotating Machinery Interfaces in the CFD Module User’s Guide.

When this physics interface is added, the following default nodes are also added in the 
Model Builder, under Mixture Model, SST — Mixture Properties, Wall, and Initial Values. 
A Moving Mesh interface with a Rotating Domain node is added automatically in the 
Model Builder under the Definitions node. Then, from the Physics toolbar, add other 
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nodes that implement, for example, boundary conditions. You can also right-click 
Mixture Model, SST to select physics features from the context menu.

The physics interface settings are the same as described for The Rotating Machinery, 
Mixture Model, Laminar Flow Interface, for Moving Mesh, and for the The Mixture 
Model, SST Interface in the CFD Module User’s Guide.

The Rotating Machinery, Mixture Model, Low Re k-ε Interface

The Rotating Machinery, Mixture Model, Low Re k-ε (mm) interface ( ) is used to 
model high Reynolds number flow of a multiphase mixture in equipment containing 
one or more rotating parts. The mixture consists of a liquid with dispersed particles, 
bubbles, liquid droplets, or solid particles, which are assumed to always travel with 
terminal velocity.

The interface solves one set of Navier-Stokes equations for the momentum of the 
mixture. The pressure distribution is calculated from a mixture-averaged continuity 
equation and the velocity of the dispersed phase is described by a slip model. The 
dispersed particles are tracked by solving a transport equation for the volume fraction 
of the dispersed phase. Turbulence effects are modeled using the AKN two-equation 
k-ε model with realizability constraints. The AKN model is a so-called 
low-Reynolds-number model, which means that it can resolve the flow all the way 
down to the wall. The AKN model depends on the distance to the closest wall. The 
physics interface therefore includes a wall distance equation.

The physics interface can also model the distribution of the number density, which in 
turn can be used to calculate the interfacial area, useful when simulating chemical 
reactions in the mixture.

There are two study types available for this physics interface. Using the Time Dependent 

with Initialization study type, the rotation is achieved through moving mesh 
functionality, also known as sliding mesh. Using the Frozen Rotor with Initialization 

study type, the rotating parts are kept frozen in position, and the rotation is accounted 
for by the inclusion of centrifugal and Coriolis forces. All study types include an initial 
Wall Distance Initialization step in order to compute the wall distance. See Theory for 
the Rotating Machinery Interfaces in the CFD Module User’s Guide.

When this physics interface is added, the following default nodes are also added in the 
Model Builder, under Mixture Model, Low Re k-ε — Mixture Properties, Wall, and Initial 

Values. A Moving Mesh interface with a Rotating Domain node is added automatically in 
the Model Builder under the Definitions node. Then, from the Physics toolbar, add other 
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nodes that implement, for example, boundary conditions. You can also right-click 
Mixture Model, Low Re k-ε to select physics features from the context menu.

The physics interface settings are the same as described for The Rotating Machinery, 
Mixture Model, Laminar Flow Interface, for Moving Mesh, and for the The Mixture 
Model, Low Re k-ε Interface in the CFD Module User’s Guide.

The Rotating Machinery, Mixture Model, Spalart-Allmaras 
Interface

The Rotating Machinery, Mixture Model, Spalart-Allmaras (mm) interface ( ) is used to 
model high Reynolds number flow of a multiphase mixture in equipment containing 
one or more rotating parts. The mixture consists of a liquid with dispersed particles, 
bubbles, liquid droplets, or solid particles, which are assumed to always travel with 
terminal velocity.

The interface solves one set of Navier-Stokes equations for the momentum of the 
mixture. The pressure distribution is calculated from a mixture-averaged continuity 
equation and the velocity of the dispersed phase is described by a slip model. The 
dispersed particles are tracked by solving a transport equation for the volume fraction 
of the dispersed phase. Turbulence effects are modeled using the Spalart-Allmaras 
one-equation model. The Spalart-Allmaras model is a so-called low-Reynolds-number 
model, which means that it can resolve the flow all the way down to the wall. The 
Spalart-Allmaras model depends on the distance to the closest wall. The physics 
interface therefore includes a wall distance equation.

The physics interface can also model the distribution of the number density, which in 
turn can be used to calculate the interfacial area, useful when simulating chemical 
reactions in the mixture.

There are two study types available for this physics interface. Using the Time Dependent 

with Initialization study type, the rotation is achieved through moving mesh 
functionality, also known as sliding mesh. Using the Frozen Rotor with Initialization 

study type, the rotating parts are kept frozen in position, and the rotation is accounted 
for by the inclusion of centrifugal and Coriolis forces. All study types include an initial 
Wall Distance Initialization step in order to compute the wall distance. See Theory for 
the Rotating Machinery Interfaces in the CFD Module User’s Guide.

When this physics interface is added, the following default nodes are also added in the 
Model Builder, under Mixture Model, Spalart-Allmaras — Mixture Properties, Wall, and 
Initial Values. A Moving Mesh interface with a Rotating Domain node is added 
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automatically in the Model Builder under the Definitions node. Then, from the Physics 
toolbar, add other nodes that implement, for example, boundary conditions. You can 
also right-click Mixture Model, Spalart-Allmaras to select physics features from the 
context menu.

The physics interface settings are the same as described for The Rotating Machinery, 
Mixture Model, Laminar Flow Interface, for Moving Mesh, and for the The Mixture 
Model, Spalart-Allmaras Interface in the CFD Module User’s Guide.

The Rotating Machinery, Mixture Model, v2-f Interface

The Rotating Machinery, Mixture Model, v2-f (mm) interface ( ) is used to model high 
Reynolds number flow of a multiphase mixture in equipment containing one or more 
rotating parts. The mixture consists of a liquid with dispersed particles, bubbles, liquid 
droplets, or solid particles, which are assumed to always travel with terminal velocity.

The interface solves one set of Navier-Stokes equations for the momentum of the 
mixture. The pressure distribution is calculated from a mixture-averaged continuity 
equation and the velocity of the dispersed phase is described by a slip model. The 
dispersed particles are tracked by solving a transport equation for the volume fraction 
of the dispersed phase. Turbulence effects are modeled using the v2-f 
transport-equation model with realizability constraints. The v2-f model is a so-called 
low-Reynolds-number model, which means that it can resolve the flow all the way 
down to the wall. The v2-f model depends on the distance to the closest wall. The 
physics interface therefore includes a wall distance equation.

The physics interface can also model the distribution of the number density, which in 
turn can be used to calculate the interfacial area, useful when simulating chemical 
reactions in the mixture.

There are two study types available for this physics interface. Using the Time Dependent 

with Initialization study type, the rotation is achieved through moving mesh 
functionality, also known as sliding mesh. Using the Frozen Rotor with Initialization 

study type, the rotating parts are kept frozen in position, and the rotation is accounted 
for by the inclusion of centrifugal and Coriolis forces. All study types include an initial 
Wall Distance Initialization step in order to compute the wall distance. See Theory for 
the Rotating Machinery Interfaces in the CFD Module User’s Guide.

When this physics interface is added, the following default nodes are also added in the 
Model Builder, under Mixture Model, v2-f — Mixture Properties, Wall, and Initial Values. 
A Moving Mesh interface with a Rotating Domain node is added automatically in the 
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Model Builder under the Definitions node. Then, from the Physics toolbar, add other 
nodes that implement, for example, boundary conditions. You can also right-click 
Mixture Model, v2-f to select physics features from the context menu.

The physics interface settings are the same as described for The Rotating Machinery, 
Mixture Model, Laminar Flow Interface, for Moving Mesh, and for the The Mixture 
Model, v2-f Interface in the CFD Module User’s Guide.

Domain, Boundary, Pair, and Point Nodes for the Rotating 
Machinery, Mixture Model Interfaces

All versions of the Rotating Machinery, Mixture Model interfaces include the 
following domain, boundary, pair, and point nodes:

The nodes are available from the Physics ribbon toolbar (Windows users), Physics 
context menu (Mac or Linux users), or right-click to access the context menu (all 
users).

The following nodes (listed in alphabetical order) are described for the Mixture Model 
interface in the CFD Module User’s Guide:

• Contact Angle

• Free Surface

• Rotating Shaft

• Gravity

• Initial Values

• Inlet

• Interior Wall

• Mass Transfer

• Mixture Properties

• Mixture Continuity

• Outlet

• Periodic Flow Condition

• Pressure Point Constraint1

• Symmetry

• Volume Force1

• Wall

1 Described for the Laminar Flow interface in the CFD Module User’s Guide.
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Free Surface

The Free Surface node is used to define the free surface separating an interior modeled 
fluid from the outer fluid. The free surface follows the fluid motion, in the normal 
direction, and is governed by the fluid motion in the free surface domain and the 
surface tension of the fluid-fluid interface. The Free Surface node can only be applied 
to outer boundaries of a Deforming Domain that do not have any boundary condition 
assigned under Moving Mesh.

To control the attachment angle between the free surface and adjacent walls, a Contact 

Angle node is by default added under the Free Surface node.

The Free Surface feature is supported by laminar flow and by turbulence models using 
wall functions or automatic wall treatment, but not low-Reynolds number wall 
treatment. It also requires the study to be time dependent. The node is inactive for 
Frozen Rotor studies.

F R E E  S U R F A C E

Enter an External pressure pext (SI unit: Pa) corresponding to the pressure level in the 
external fluid phase.

S U R F A C E  T E N S I O N

The Surface tension coefficient σ (SI unit: N/m) can be specified from predefined 
libraries, by selecting Library coefficient, liquid/gas interface (the default) or Library 

coefficient, liquid/liquid interface, or set to User defined.

• For Library coefficient, liquid/gas interface select an option from the list — Water/Air 
(the default), Acetone/Air, Acetic acid/Air, Ethanol/Air, Ethylene glycol/Ethylene glycol 

vapor, Diethyl ether/Air, Glycerol/Air, Heptane/Nitrogen, Mercury/Mercury vapor, or 
Toluene/Air.

• For Library coefficient, liquid/liquid interface select an option from the list — 
Benzene/Water, 20°C, Corn oil/Water, 20°C, Ether/Water, 20°C, Hexane/Water, 20°C, 
Mercury/Water, 20°C, or Olive oil/Water, 20°C.

D I S P E R S E D  P H A S E  B O U N D A R Y  C O N D I T I O N

Select an option from the Dispersed phase boundary condition list—No dispersed phase 

flux (the default), Dispersed phase concentration, Dispersed phase outlet, Dispersed phase 

flux, or Symmetry.

• For Dispersed phase concentration enter a Dispersed phase volume fraction  
(dimensionless). The default is 0. When Solve for interfacial area is selected under 

φd0
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the Physical Model section, select either the Dispersed phase number density n0 
(SI unit: 1/m3) or Diameter of particles/droplets dd (SI unit: m) button and enter a 
value or expression for n0 (the default is 5·106 1/m3) or dd (the default is 1 mm).

• For Dispersed phase flux enter values or expression for the Dispersed phase flux  
(SI unit: m/s) and, if Solve for interfacial area is selected under the Physical Model 
section, the Number density flux Νn (SI unit: 1/(m2⋅s)). The defaults are 0 m/s and 
0 1/(m2⋅s), respectively.

L O C A T I O N  I N  U S E R  I N T E R F A C E

Context Menus
Right click the physics interface and select Rotating Machinery>Free Surface

Ribbon
Physics tab with the physics interface selected:

Boundaries>Rotating Machinery>Free Surface

Nφd

Dispersed Phase Boundary Conditions Equations in the CFD Module 
User’s Guide

The Free Surface feature imposes a mesh deformation in the normal 
direction. On adjacent boundaries, the mesh displacement parallel to 
those boundaries cannot be fixed if the contact point is moving. In this 
case a Mesh Slip, Symmetry/Roller, Prescribed Normal Mesh 
Displacement, or Prescribed Normal Mesh Velocity boundary condition 
under Moving Mesh should be selected. A Mesh Slip condition is 
automatically used on the boundaries that are adjacent to the Free Surface 
and dot not have a prescribed Moving Mesh boundary condition.

If a Free Surface feature is in contact with a solid boundary, the movement 
of the contact point is not compatible with the no slip condition. For 
laminar flow the Wall feature with the Navier Slip option should be 
selected. For turbulence models with wall functions or automatic wall 
treatment the Wall feature with the No Slip option can be selected.
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Contact Angle 

This feature specifies the contact angle between the free surface and a solid wall. The 
Contact Angle feature is a subfeature to, and added under a Free Surface feature.

C O N T A C T  A N G L E

Select an option from the Specify contact angle list—Directly (the default) or Through 

Young’s equation.

• For Directly enter a Contact angle θw (SI unit: rad). The default is π/2.

• For Through Young’s equation enter values or expressions for Phase 1-Solid surface 

energy density γs1 (SI unit: J/m2) and Phase 2-Solid surface energy density γs2 (SI 
unit: J/m2).

This condition applies forces on the wall that balance the surface tension for the 
prescribed contact angle. 

For laminar flow, the Contact Angle node should be used on edges or points where a 
Navier Slip wall boundary condition is applied adjacent to the free surface. In this case, 
the Navier Slip condition is required for the contact line to move along the wall.

The representation of the contact angle is dependent on the mesh resolution in the 
region where the fluid-fluid interface attaches to the wall. If, during the simulation, the 
contact angle is found to fluctuate around a given value, this indicates that the 
resolution needs to be improved. This can for example be achieved by adding more 
mesh boundary layers on the wall.

Rotating Shaft

Use the Rotating Shaft node to define boundaries where the fluid is subjected to a solid 
shaft rotation. This feature should be applied to boundaries outside of, but connecting 
to, a Rotating Domain. This feature can be applied to rotating shaft boundaries in a 
free-surface domain modeled by a Deforming Domain.

The moving mesh boundary condition must be compatible with the 
motion of the wall for the problem to have a valid solution.
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R O T A T I N G  S H A F T

Axis of Rotation
Select the Axis of rotation. If x-axis is selected, this corresponds to a rotational axis 
(1, 0, 0) with the origin as the base point. Correspondingly, if y-axis or z-axis is 
selected, the rotational axis is defined by a unit vector in the selected direction together 
with a base point at the origin. For User defined enter values into these fields: Rotation 

axis base point and Rotation axis direction. The z-axis is the default choice and the 
default values in the fields for User defined correspond to those for the z-axis.

Angular Velocity
Select the rotating shaft Rotational frequency from the list:

• Select the Revolution per time option to manually define the rotational velocity (SI 
unit: rad/s) and select the Rotational direction as Positive angular velocity or Negative 

angular velocity. This is the default setting.

• Select the Angular velocity option to manually define the angular velocity (SI unit: 
rad/s).

D I S P E R S E D  P H A S E  B O U N D A R Y  C O N D I T I O N

Select an option from the Dispersed phase boundary condition list—No dispersed phase 

flux (the default), Dispersed phase concentration, Dispersed phase outlet, Dispersed phase 

flux, or Symmetry.

• For Dispersed phase concentration enter a Dispersed phase volume fraction  
(dimensionless). The default is 0. When Solve for interfacial area is selected under 
the Physical Model section, select either the Dispersed phase number density n0 
(SI unit: 1/m3) or Diameter of particles/droplets dd (SI unit: m) button and enter a 
value or expression for n0 (the default is 5·106 1/m3) or dd (the default is 1 mm).

• For Dispersed phase flux enter values or expression for the Dispersed phase flux  
(SI unit: m/s) and, if Solve for interfacial area is selected under the Physical Model 
section, the Number density flux Νn (SI unit: 1/(m2⋅s)). The defaults are 0 m/s and 
0 1/(m2⋅s), respectively.

φd0

Nφd

Dispersed Phase Boundary Conditions Equations in the CFD Module 
User’s Guide
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L O C A T I O N  I N  U S E R  I N T E R F A C E

Context Menus
Right click the physics interface and select Rotating Machinery>Rotating Shaft

Ribbon
Physics tab with the physics interface selected:

Boundaries>Rotating Machinery>Rotating Shaft
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R o t a t i n g  M a c h i n e r y ,
N o n i s o t h e r m a l F l o w  I n t e r f a c e s
This chapter describes the multiphysics interfaces found under the Fluid 

Flow>Nonisothermal Flow>Rotating Machinery, Nonisothermal Flow branch ( ). In 
this chapter:

• Rotating Machinery, Nonisothermal Flow, Laminar Flow Interface

• Rotating Machinery, Nonisothermal Flow, Turbulent Flow, Algebraic yPlus 
Interface

• Rotating Machinery, Nonisothermal Flow, Turbulent Flow, L-VEL Interface

• Rotating Machinery, Nonisothermal Flow, Turbulent Flow, k-ε Interface

• Rotating Machinery, Nonisothermal Flow, Turbulent Flow, Realizable k-ε 
Interface

• Rotating Machinery, Nonisothermal Flow, Turbulent Flow, k-ω Interface

• Rotating Machinery, Nonisothermal Flow, Turbulent Flow, SST Interface

• Rotating Machinery, Nonisothermal Flow, Turbulent Flow, Low Re k-ε 
Interface

• Rotating Machinery, Nonisothermal Flow, Turbulent Flow, k-ω Interface
 109
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• Rotating Machinery, Nonisothermal Flow, Turbulent Flow, v2-f Interface

• Domain, Boundary, Edge, Point, and Pair Nodes for the Rotating Machinery, 
Nonisothermal Flow Interfaces
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Rotating Machinery, Nonisothermal Flow, Laminar Flow Interface

The Laminar Flow version of the Rotating Machinery, Nonisothermal Flow multiphysics 
interface ( ), found under the Fluid Flow>Nonisothermal Flow>Rotating Machinery, 

Nonisothermal Flow branch ( ) when adding a physics interface, is used to simulate 
laminar flow and heat transfer in equipment containing one or more rotating parts.

This physics interface combines the capabilities of the Rotating Machinery, Laminar 
Flow interface and the Heat Transfer in Fluids interface, and can be used to simulate 
fluid flows where the fluid properties depend on the temperature. Furthermore it is 
also possible to include heat transfer in solids, stationary and rotating, as well as 
surface-to-surface radiation and radiation in participating media. The physics interface 
is available in 2D and 3D and supports low Mach number (typically less than 0.3) 
flows, as well as non-Newtonian fluids.

Four study types are available for this physics interface. Using the Time Dependent study 
type, the rotation is achieved through moving mesh functionality, also known as sliding 
mesh. Using the Frozen Rotor study, the rotating parts are kept frozen in position, and 
the rotation is accounted for by the inclusion of centrifugal and Coriolis forces.The 
Time Dependent, One-Way Coupled, NITF and Frozen Rotor, One-Way Coupled, NITF study 
are used for frozen rotor and time dependent nonisothermal flow computations where 
the model is one-way coupled in the sense that the temperature variations are so small 
that they do not affect the flow.

When adding the multiphysics interface, the Laminar Flow and Heat Transfer in Fluids 
interfaces are added to the Model Builder. A Moving Mesh interface with a Rotating 

Domain node is added automatically in the Model Builder under the Definitions node. In 
addition, the Multiphysics node is added, which automatically includes the multiphysics 
coupling feature Nonisothermal Flow. The following default nodes are also added in the 
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Model Builder under Laminar Flow — Fluid Properties, Wall, and Initial Values; and under 
Heat Transfer in Fluids — Fluid, Thermal Insulation, and Initial Values.

Rotating Machinery, Nonisothermal Flow, Turbulent Flow, Algebraic 
yPlus Interface

The Turbulent Flow, Algebraic yPlus version of the Rotating Machinery, Nonisothermal 

Flow interface ( ), found under the Fluid Flow>Nonisothermal Flow>Rotating 

Machinery, Nonisothermal Flow branch ( ) when adding a physics interface, is used to 
simulate turbulent flow and heat transfer in equipment containing one or more 
rotating parts.

This physics interface combines the capabilities of the Rotating Machinery, Turbulent 
Flow, Algebraic yPlus interface and the Heat Transfer in Fluids interface, and can be 
used to simulate high Reynolds number flows where the fluid properties depend on 
the temperature. Furthermore it is also possible to include heat transfer in solids, 
stationary and rotating, as well as surface-to-surface radiation and radiation in 

In previous versions of COMSOL Multiphysics (prior to version 5.4), a 
specific physics interface called Rotating Machinery, Nonisothermal Flow 

(rmnitf) was added to the Model Builder. Now, a predefined multiphysics 
coupling approach is used, improving the flexibility and design options 
for your modeling. For specific details, see The Multiphysics Branch and 
Multiphysics Modeling Approaches in the COMSOL Multiphysics 
Reference Manual.

• Domain, Boundary, Edge, Point, and Pair Nodes for the Rotating 
Machinery, Nonisothermal Flow Interfaces

• Moving Mesh

• Theory for the Free Surface Features

In the CFD Module User’s Guide:

• Modeling Heat Transfer in the CFD Module

• The Nonisothermal Flow and Conjugate Heat Transfer, Laminar Flow 
and Turbulent Flow Interfaces

• Theory for the Nonisothermal Flow and Conjugate Heat Transfer 
Interfaces
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participating media. The physics interface is available in 2D and 3D and supports low 
Mach number (typically less than 0.3) flows, as well as non-Newtonian fluids.

The physics interface solves for conservation of energy, mass, and momentum in fluids, 
and for conservation of energy in solids. The interface also solves an algebraic equation 
for the scaled wall distance. Turbulence effects are included using an enhanced 
viscosity model based on the scaled wall distance, and the physics interface therefore 
includes a wall distance equation.

Four study types available for this physics interface. Using the Transient with 

Initialization study type, the rotation is achieved through moving mesh functionality, 
also known as sliding mesh. Using the Frozen Rotor with Initialization study type, the 
rotating parts are kept frozen in position, and the rotation is accounted for by the 
inclusion of centrifugal and Coriolis forces. The Time Dependent, One-Way Coupled, 

NITF and Frozen Rotor, One-Way Coupled, NITF study are used for frozen rotor and time 
dependent nonisothermal flow computations where the model is one-way coupled in 
the sense that the temperature variations are so small that they do not affect the flow. 
All study types include an initial Wall Distance Initialization step in order to compute 
the wall distance. See Theory for the Rotating Machinery Interfaces in the CFD 
Module User’s Guide.

When adding the multiphysics interface, the Turbulent Flow, Algebraic yPlus and Heat 

Transfer in Fluids interfaces are added to the Model Builder. A Moving Mesh interface 
with a Rotating Domain node is added automatically in the Model Builder under the 
Definitions node. In addition, the Multiphysics node is added, which automatically 
includes the multiphysics coupling feature Nonisothermal Flow. The following default 
nodes are also added in the Model Builder under Turbulent Flow, Algebraic yPlus — Fluid 

Properties, Wall, and Initial Values; and under Heat Transfer in Fluids— Fluid, Thermal 

Insulation, and Initial Values.

See Rotating Machinery, Nonisothermal Flow, Laminar Flow Interface for details.

Rotating Machinery, Nonisothermal Flow, Turbulent Flow, L-VEL 
Interface

The Turbulent Flow, L-VEL version of the Rotating Machinery, Nonisothermal Flow 
interface ( ), found under the Fluid Flow>Nonisothermal Flow>Rotating Machinery, 

Nonisothermal Flow branch ( ) when adding a physics interface, is used to simulate 
turbulent flow and heat transfer in equipment containing one or more rotating parts.
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This physics interface combines the capabilities of the Rotating Machinery, Turbulent 
Flow, L-VEL interface and the Heat Transfer in Fluids interface, and can be used to 
simulate high Reynolds number flows where the fluid properties depend on the 
temperature. Furthermore it is also possible to include heat transfer in solids, 
stationary and rotating, as well as surface-to-surface radiation and radiation in 
participating media. The physics interface is available in 2D and 3D and supports low 
Mach number (typically less than 0.3) flows, as well as non-Newtonian fluids.

The physics interface solves for conservation of energy, mass, and momentum in fluids, 
and for conservation of energy in solids. The interface also solves an algebraic equation 
for the scaled fluid flow velocity tangential to the nearest wall. Turbulence effects are 
included using an enhanced viscosity model based on the scaled wall distance, and the 
physics interface therefore includes a wall distance equation.

Four study types available for this physics interface. Using the Transient with 

Initialization study type, the rotation is achieved through moving mesh functionality, 
also known as sliding mesh. Using the Frozen Rotor with Initialization study type, the 
rotating parts are kept frozen in position, and the rotation is accounted for by the 
inclusion of centrifugal and Coriolis forces. The Time Dependent, One-Way Coupled, 

NITF and Frozen Rotor, One-Way Coupled, NITF study are used for frozen rotor and time 
dependent nonisothermal flow computations where the model is one-way coupled in 
the sense that the temperature variations are so small that they do not affect the flow. 
All study types include an initial Wall Distance Initialization step in order to compute 
the wall distance. See Theory for the Rotating Machinery Interfaces in the CFD 
Module User’s Guide.

When adding the multiphysics interface, the Turbulent Flow, L-VEL and Heat Transfer in 

Fluids interfaces are added to the Model Builder. A Moving Mesh interface with a 
Rotating Domain node is added automatically in the Model Builder under the Definitions 
node. In addition, the Multiphysics node is added, which automatically includes the 
multiphysics coupling feature Nonisothermal Flow. The following default nodes are also 
added in the Model Builder under Turbulent Flow, L-VEL — Fluid Properties, Wall, and 
Initial Values; and under Heat Transfer in Fluids— Fluid, Thermal Insulation, and Initial 

Values.

See Rotating Machinery, Nonisothermal Flow, Laminar Flow Interface for details.
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Rotating Machinery, Nonisothermal Flow, Turbulent Flow, k-ε 
Interface

The Turbulent Flow, k-ε version of the Rotating Machinery, Nonisothermal Flow (rmnitf) 
interface ( ), found under the Fluid Flow>Nonisothermal Flow>Rotating Machinery, 

Nonisothermal Flow branch ( ) when adding a physics interface, is used to simulate 
turbulent flow and heat transfer in equipment containing one or more rotating parts.

This physics interface combines the capabilities of the Rotating Machinery, Turbulent 
Flow, k-ε interface and the Heat Transfer in Fluids interface, and can be used to 
simulate high Reynolds number fluid flows where the fluid properties depend on the 
temperature. Furthermore it is also possible to include heat transfer in solids, 
stationary and rotating, as well as surface-to-surface radiation and radiation in 
participating media. The physics interface is available in 2D and 3D and supports low 
Mach number (typically less than 0.3) flows, as well as non-Newtonian fluids.

The physics interface solves for conservation of energy, mass, and momentum in fluids, 
and for conservation of energy in solids. Turbulence effects are modeled using the 
standard two-equation k-ε model with realizability constraints. Flow and heat transfer 
close to walls are modeled using wall functions.

Four study types are available for this physics interface. Using the Time Dependent study 
type, the rotation is achieved through moving mesh functionality, also known as sliding 
mesh. Using the Frozen Rotor study, the rotating parts are kept frozen in position, and 
the rotation is accounted for by the inclusion of centrifugal and Coriolis forces.The 
Time Dependent, One-Way Coupled, NITF and Frozen Rotor, One-Way Coupled, NITF study 
are used for frozen rotor and time dependent nonisothermal flow computations where 
the model is one-way coupled in the sense that the temperature variations are so small 
that they do not affect the flow.

When adding the multiphysics interface, the Turbulent Flow, k-ε and Heat Transfer in 

Fluids interfaces are added to the Model Builder. A Moving Mesh interface with a 
Rotating Domain node is added automatically in the Model Builder under the Definitions 
node. In addition, the Multiphysics node is added, which automatically includes the 
multiphysics coupling feature Nonisothermal Flow. The following default nodes are also 
added in the Model Builder under Turbulent Flow, k-ε — Fluid Properties, Wall, and Initial 

Values; and under Heat Transfer in Fluids — Fluid, Thermal Insulation, and Initial Values.

See Rotating Machinery, Nonisothermal Flow, Laminar Flow Interface for details.
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Rotating Machinery, Nonisothermal Flow, Turbulent Flow, 
Realizable k-ε Interface

The Turbulent Flow, Realizable k-ε version of the Rotating Machinery, Nonisothermal Flow 

(rmnitf) interface ( ), found under the Fluid Flow>Nonisothermal Flow>Rotating 

Machinery, Nonisothermal Flow branch ( ) when adding a physics interface, is used to 
simulate turbulent flow and heat transfer in equipment containing one or more 
rotating parts.

This physics interface combines the capabilities of the Rotating Machinery, Turbulent 
Flow, Realizable k-ε interface and the Heat Transfer in Fluids interface, and can be 
used to simulate high Reynolds number fluid flows where the fluid properties depend 
on the temperature. Furthermore it is also possible to include heat transfer in solids, 
stationary and rotating, as well as surface-to-surface radiation and radiation in 
participating media. The physics interface is available in 2D and 3D and supports low 
Mach number (typically less than 0.3) flows, as well as non-Newtonian fluids.

The physics interface solves for conservation of energy, mass, and momentum in fluids, 
and for conservation of energy in solids. Turbulence effects are modeled using the 
Realizable two-equation k-ε model. Flow and heat transfer close to walls are modeled 
using wall functions.

Four study types are available for this physics interface. Using the Time Dependent study 
type, the rotation is achieved through moving mesh functionality, also known as sliding 
mesh. Using the Frozen Rotor study, the rotating parts are kept frozen in position, and 
the rotation is accounted for by the inclusion of centrifugal and Coriolis forces.The 
Time Dependent, One-Way Coupled, NITF and Frozen Rotor, One-Way Coupled, NITF study 
are used for frozen rotor and time dependent nonisothermal flow computations where 
the model is one-way coupled in the sense that the temperature variations are so small 
that they do not affect the flow.

When adding the multiphysics interface, the Turbulent Flow, Realizable k-ε and Heat 

Transfer in Fluids interfaces are added to the Model Builder. A Moving Mesh interface 
with a Rotating Domain node is added automatically in the Model Builder under the 
Definitions node. In addition, the Multiphysics node is added, which automatically 
includes the multiphysics coupling feature Nonisothermal Flow. The following default 
nodes are also added in the Model Builder under Turbulent Flow, Realizable k-ε — Fluid 

Properties, Wall, and Initial Values; and under Heat Transfer in Fluids — Fluid, Thermal 

Insulation, and Initial Values.

See Rotating Machinery, Nonisothermal Flow, Laminar Flow Interface for details.
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Rotating Machinery, Nonisothermal Flow, Turbulent Flow, k-ω 
Interface

The Turbulent Flow, k-ω version of the Rotating Machinery, Nonisothermal Flow 
interface ( ), found under the Fluid Flow>Nonisothermal Flow>Rotating Machinery, 

Nonisothermal Flow branch ( ) when adding a physics interface, is used to simulate 
turbulent flow and heat transfer in equipment containing one or more rotating parts.

This physics interface combines the capabilities of the Rotating Machinery, Turbulent 
Flow, k-ω interface and the Heat Transfer in Fluids interface, and can be used to 
simulate high Reynolds number fluid flows where the fluid properties depend on the 
temperature. Furthermore it is also possible to include heat transfer in solids, 
stationary and rotating, as well as surface-to-surface radiation and radiation in 
participating media. The physics interface is available in 2D and 3D and supports low 
Mach number (typically less than 0.3) flows, as well as non-Newtonian fluids.

The physics interface solves for conservation of energy, mass, and momentum in fluids 
and for conservation of energy in solids. Turbulence effects are modeled using the 
Wilcox revised two-equation k-ω model with realizability constraints. The k-ω model 
is a so-called low-Reynolds number model, which means that it can resolve the flow 
and heat transfer all the way down to the wall.

Four study types are available for this physics interface. Using the Time Dependent study 
type, the rotation is achieved through moving mesh functionality, also known as sliding 
mesh. Using the Frozen Rotor study, the rotating parts are kept frozen in position, and 
the rotation is accounted for by the inclusion of centrifugal and Coriolis forces.The 
Time Dependent, One-Way Coupled, NITF and Frozen Rotor, One-Way Coupled, NITF study 
are used for frozen rotor and time dependent nonisothermal flow computations where 
the model is one-way coupled in the sense that the temperature variations are so small 
that they do not affect the flow.

When adding the multiphysics interface, the Turbulent Flow, k-ω and Heat Transfer in 

Fluids interfaces are added to the Model Builder. A Moving Mesh interface with a 
Rotating Domain node is added automatically in the Model Builder under the Definitions 
node. In addition, the Multiphysics node is added, which automatically includes the 
multiphysics coupling feature Nonisothermal Flow. The following default nodes are also 
added in the Model Builder under Turbulent Flow, k-ω — Fluid Properties, Wall, and 
Initial Values; and under Heat Transfer in Fluids — Fluid, Thermal Insulation, and Initial 

Values.

See Rotating Machinery, Nonisothermal Flow, Laminar Flow Interface for details.
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Rotating Machinery, Nonisothermal Flow, Turbulent Flow, SST 
Interface

The Turbulent Flow, SST version of the Rotating Machinery, Nonisothermal Flow 
interface ( ), found under the Fluid Flow>Nonisothermal Flow>Rotating Machinery, 

Nonisothermal Flow branch ( ) when adding a physics interface, is used to simulate 
turbulent flow and heat transfer in equipment containing one or more rotating parts.

This physics interface combines the capabilities of the Rotating Machinery, Turbulent 
Flow, SST interface and the Heat Transfer in Fluids interface, and can be used to 
simulate high Reynolds number fluid flows where the fluid properties depend on the 
temperature. Furthermore it is also possible to include heat transfer in solids, 
stationary and rotating, as well as surface-to-surface radiation and radiation in 
participating media. The physics interface is available in 2D and 3D and supports low 
Mach number (typically less than 0.3) flows, as well as non-Newtonian fluids.

The physics interface solves for conservation of energy, mass, and momentum in fluids 
and for conservation of energy in solids. Turbulence effects are modeled using the SST 
two-equation model with realizability constraints. The SST model is a so-called 
low-Reynolds number model, which means that it can resolve the flow and heat 
transfer all the way down to the wall. The SST model depends on the distance to the 
closest wall. The physics interface therefore includes a wall distance equation.

Four study types available for this physics interface. Using the Transient with 

Initialization study type, the rotation is achieved through moving mesh functionality, 
also known as sliding mesh. Using the Frozen Rotor with Initialization study type, the 
rotating parts are kept frozen in position, and the rotation is accounted for by the 
inclusion of centrifugal and Coriolis forces. The Time Dependent, One-Way Coupled, 

NITF and Frozen Rotor, One-Way Coupled, NITF study are used for frozen rotor and time 
dependent nonisothermal flow computations where the model is one-way coupled in 
the sense that the temperature variations are so small that they do not affect the flow. 
All study types include an initial Wall Distance Initialization step in order to compute 
the wall distance. See Theory for the Rotating Machinery Interfaces in the CFD 
Module User’s Guide.

When adding the multiphysics interface, the Turbulent Flow, SST and Heat Transfer in 

Fluids interfaces are added to the Model Builder. A Moving Mesh interface with a 
Rotating Domain node is added automatically in the Model Builder under the Definitions 
node. In addition, the Multiphysics node is added, which automatically includes the 
multiphysics coupling feature Nonisothermal Flow. The following default nodes are also 
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added in the Model Builder under Turbulent Flow, SST — Fluid Properties, Wall, and Initial 

Values; and under Heat Transfer in Fluids— Fluid, Thermal Insulation, and Initial Values.

See Rotating Machinery, Nonisothermal Flow, Laminar Flow Interface for details.

Rotating Machinery, Nonisothermal Flow, Turbulent Flow, Low Re 
k-ε Interface

The Turbulent Flow, Low Re k-ε version of the Rotating Machinery, Nonisothermal Flow 

interface ( ), found under the Fluid Flow>Nonisothermal Flow>Rotating Machinery, 

Nonisothermal Flow branch ( ) when adding a physics interface, is used to simulate 
turbulent flow and heat transfer in equipment containing one or more rotating parts.

This physics interface combines the capabilities of the Rotating Machinery, Turbulent 
Flow, Low Re k-ε interface and the Heat Transfer in Fluids interface, and can be used 
to simulate high Reynolds number fluid flows where the fluid properties depend on 
the temperature. Furthermore it is also possible to include heat transfer in solids, 
stationary and rotating, as well as surface-to-surface radiation and radiation in 
participating media. The physics interface is available in 2D and 3D and supports low 
Mach number (typically less than 0.3) flows, as well as non-Newtonian fluids.

The physics interface solves for conservation of energy, mass, and momentum in fluids 
and for conservation of energy in solids. Turbulence effects are modeled using the 
AKN two-equation k-ε model with realizability constraints. The AKN model is a 
so-called low-Reynolds number model, which means that it can resolve the flow and 
heat transfer all the way down to the wall. The AKN model depends on the distance 
to the closest wall. The physics interface therefore includes a wall distance equation.

Four study types available for this physics interface. Using the Transient with 

Initialization study type, the rotation is achieved through moving mesh functionality, 
also known as sliding mesh. Using the Frozen Rotor with Initialization study type, the 
rotating parts are kept frozen in position, and the rotation is accounted for by the 
inclusion of centrifugal and Coriolis forces. The Time Dependent, One-Way Coupled, 

NITF and Frozen Rotor, One-Way Coupled, NITF study are used for frozen rotor and time 
dependent nonisothermal flow computations where the model is one-way coupled in 
the sense that the temperature variations are so small that they do not affect the flow. 
All study types include an initial Wall Distance Initialization step in order to compute 
the wall distance. See Theory for the Rotating Machinery Interfaces in the CFD 
Module User’s Guide.
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When adding the multiphysics interface, the Turbulent Flow, low Re k-ε and Heat 

Transfer in Fluids interfaces are added to the Model Builder. A Moving Mesh interface 
with a Rotating Domain node is added automatically in the Model Builder under the 
Definitions node. In addition, the Multiphysics node is added, which automatically 
includes the multiphysics coupling feature Nonisothermal Flow. The following default 
nodes are also added in the Model Builder under Turbulent Flow, low Re k-ε — Fluid 

Properties, Wall, and Initial Values; and under Heat Transfer in Fluids— Fluid, Thermal 

Insulation, and Initial Values.

See Rotating Machinery, Nonisothermal Flow, Laminar Flow Interface for details.

Rotating Machinery, Nonisothermal Flow, Turbulent Flow, 
Spalart-Allmaras Interface

The Turbulent Flow, Spalart-Allmaras version of the Rotating Machinery, Nonisothermal 

Flow interface ( ), found under the Fluid Flow>Nonisothermal Flow>Rotating 

Machinery, Nonisothermal Flow branch ( ) when adding a physics interface, is used to 
simulate turbulent flow and heat transfer in equipment containing one or more 
rotating parts.

This physics interface combines the capabilities of the Rotating Machinery, Turbulent 
Flow, Spalart-Allmaras interface and the Heat Transfer in Fluids interface, and can be 
used to simulate high Reynolds number flows where the fluid properties depend on 
the temperature. Furthermore it is also possible to include heat transfer in solids, 
stationary and rotating, as well as surface-to-surface radiation and radiation in 
participating media. The physics interface is available in 2D and 3D and supports low 
Mach number (typically less than 0.3) flows, as well as non-Newtonian fluids.

The physics interface solves for conservation of energy, mass, and momentum in fluids 
and for conservation of energy in solids. Turbulence effects are modeled using the 
Spalart-Allmaras one-equation model. The Spalart-Allmaras model is a so-called 
low-Reynolds number model, which means that it can resolve the flow and heat 
transfer all the way down to the wall. The Spalart-Allmaras model depends on the 
distance to the closest wall, and the physics interface therefore includes a wall distance 
equation.

Four study types available for this physics interface. Using the Transient with 

Initialization study type, the rotation is achieved through moving mesh functionality, 
also known as sliding mesh. Using the Frozen Rotor with Initialization study type, the 
rotating parts are kept frozen in position, and the rotation is accounted for by the 
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inclusion of centrifugal and Coriolis forces. The Time Dependent, One-Way Coupled, 

NITF and Frozen Rotor, One-Way Coupled, NITF study are used for frozen rotor and time 
dependent nonisothermal flow computations where the model is one-way coupled in 
the sense that the temperature variations are so small that they do not affect the flow. 
All study types include an initial Wall Distance Initialization step in order to compute 
the wall distance. See Theory for the Rotating Machinery Interfaces in the CFD 
Module User’s Guide.

When adding the multiphysics interface, the Turbulent Flow, Spalart-Allmaras and Heat 

Transfer in Fluids interfaces are added to the Model Builder. A Moving Mesh interface 
with a Rotating Domain node is added automatically in the Model Builder under the 
Definitions node. In addition, the Multiphysics node is added, which automatically 
includes the multiphysics coupling feature Nonisothermal Flow. The following default 
nodes are also added in the Model Builder under Turbulent Flow, Spalart-Allmaras — Fluid 

Properties, Wall, and Initial Values; and under Heat Transfer in Fluids— Fluid, Thermal 

Insulation, and Initial Values.

See Rotating Machinery, Nonisothermal Flow, Laminar Flow Interface for details.

Rotating Machinery, Nonisothermal Flow, Turbulent Flow, v2-f 
Interface

The Turbulent Flow, v2-f version of the Rotating Machinery, Nonisothermal Flow 

interface ( ), found under the Fluid Flow>Nonisothermal Flow>Rotating Machinery, 

Nonisothermal Flow branch ( ) when adding a physics interface, is used to simulate 
turbulent flow and heat transfer in equipment containing one or more rotating parts.

This physics interface combines the capabilities of the Rotating Machinery, Turbulent 
Flow, v2-f interface and the Heat Transfer in Fluids interface, and can be used to 
simulate high Reynolds number flows where the fluid properties depend on the 
temperature. Furthermore it is also possible to include heat transfer in solids, 
stationary and rotating, as well as surface-to-surface radiation and radiation in 
participating media. The physics interface is available in 2D and 3D and supports low 
Mach number (typically less than 0.3) flows, as well as non-Newtonian fluids.

The physics interface solves for conservation of energy, mass, and momentum in fluids 
and for conservation of energy in solids. Turbulence effects are modeled using the v2-f 
transport-equation model with realizability constraints. The v2-f model is a so-called 
low-Reynolds number model, which means that it can resolve the flow and heat 
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transfer all the way down to the wall. The physics interface includes a wall distance 
equation.

Four study types available for this physics interface. Using the Transient with 

Initialization study type, the rotation is achieved through moving mesh functionality, 
also known as sliding mesh. Using the Frozen Rotor with Initialization study type, the 
rotating parts are kept frozen in position, and the rotation is accounted for by the 
inclusion of centrifugal and Coriolis forces. The Time Dependent, One-Way Coupled, 

NITF and Frozen Rotor, One-Way Coupled, NITF study are used for frozen rotor and time 
dependent nonisothermal flow computations where the model is one-way coupled in 
the sense that the temperature variations are so small that they do not affect the flow. 
All study types include an initial Wall Distance Initialization step in order to compute 
the wall distance. See Theory for the Rotating Machinery Interfaces in the CFD 
Module User’s Guide.

When adding the multiphysics interface, the Turbulent Flow, v2-f and Heat Transfer in 

Fluids interfaces are added to the Model Builder. A Moving Mesh interface with a 
Rotating Domain node is added automatically in the Model Builder under the Definitions 
node. In addition, the Multiphysics node is added, which automatically includes the 
multiphysics coupling feature Nonisothermal Flow. The following default nodes are also 
added in the Model Builder under Turbulent Flow, v2-f — Fluid Properties, Wall, and 
Initial Values; and under Heat Transfer in Fluids— Fluid, Thermal Insulation, and Initial 

Values.

See Rotating Machinery, Nonisothermal Flow, Laminar Flow Interface for details.

Domain, Boundary, Edge, Point, and Pair Nodes for the Rotating 
Machinery, Nonisothermal Flow Interfaces

Physics nodes are available from the Physics ribbon toolbar (Windows users), Physics 
context menu (Mac or Linux users), or right-click to access the context menu (all 
users).

In general, to add a node, go to the Physics toolbar, no matter what 
operating system you are using. 
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H E A T  T R A N S F E R  I N  F L U I D S  ( N O N I S O T H E R M A L  F L O W )

The available physics features for The Heat Transfer in Fluids Interface are listed in the 
section Feature Nodes for the Heat Transfer in Fluids Interface. Also see Fluid for 
details about that feature.

L A M I N A R  F L O W

The available physics features for The Rotating Machinery, Laminar Flow Interface are 
listed in the section Domain, Boundary, Point, and Pair Nodes for the Rotating 
Machinery Interfaces.

T U R B U L E N T  F L O W ,  A L G E B R A I C  Y P L U S

The available physics features for The Rotating Machinery, Turbulent Flow, Algebraic 
yPlus Interface are listed in the section Domain, Boundary, Point, and Pair Nodes for 
the Rotating Machinery Interfaces.

T U R B U L E N T  F L O W ,  L - V E L

The available physics features for The Rotating Machinery, Turbulent Flow, L-VEL 
Interface are listed in the section Domain, Boundary, Point, and Pair Nodes for the 
Rotating Machinery Interfaces.

T U R B U L E N T  F L O W ,  k-ε
The available physics features for The Rotating Machinery, Turbulent Flow, k-ε 
Interface are listed in the section Domain, Boundary, Point, and Pair Nodes for the 
Rotating Machinery Interfaces.

T U R B U L E N T  F L O W ,  R E A L I Z A B L E  k-ε
The available physics features for The Rotating Machinery, Turbulent Flow, Realizable 
k-ε Interface are listed in the section Domain, Boundary, Point, and Pair Nodes for the 
Rotating Machinery Interfaces.

T U R B U L E N T  F L O W ,  k-ω
The available physics features for The Rotating Machinery, Turbulent Flow, k-ω 
Interface are listed in the section Domain, Boundary, Point, and Pair Nodes for the 
Rotating Machinery Interfaces.

T U R B U L E N T  F L O W ,  S S T

The available physics features for The Rotating Machinery, Turbulent Flow, SST 
Interface are listed in the section Domain, Boundary, Point, and Pair Nodes for the 
Rotating Machinery Interfaces.
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T U R B U L E N T  F L O W ,  L O W  R E  k-ε
The available physics features for The Rotating Machinery, Turbulent Flow, Low Re 
k-ε Interface are listed in the section Domain, Boundary, Point, and Pair Nodes for the 
Rotating Machinery Interfaces.

T U R B U L E N T  F L O W ,  S P A L A R T - A L L M A R A S

The available physics features for The Rotating Machinery, Turbulent Flow, 
Spalart-Allmaras Interface are listed in the section Domain, Boundary, Point, and Pair 
Nodes for the Rotating Machinery Interfaces.

T U R B U L E N T  F L O W ,  V 2 - F

The available physics features for The Rotating Machinery, Turbulent Flow, v2-f 
Interface are listed in the section Domain, Boundary, Point, and Pair Nodes for the 
Rotating Machinery Interfaces.
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R o t a t i n g  M a c h i n e r y ,
R e a c t i n g F l o w I n t e r f a c e s
This chapter describes the physics interfaces found under the Chemical Species 

Transport>Rotating Machinery, Reacting Flow branch ( ).

In this chapter:

• The Rotating Machinery, Reacting Flow, Laminar Flow Interface

• The Rotating Machinery, Reacting Flow, Turbulent Flow, k-ε Interface

• The Rotating Machinery, Reacting Flow, Turbulent Flow, k-ω Interface

• The Rotating Machinery, Reacting Flow, Turbulent Flow, SST Interface

• The Rotating Machinery, Reacting Flow, Turbulent Flow, Low Re k-ε Interface

• Domain, Boundary, Point, and Pair Nodes for the Rotating Machinery, Reacting 
Flow Interfaces
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Th e  Ro t a t i n g  Ma ch i n e r y ,  R e a c t i n g  
F l ow ,  L am i n a r  F l ow and Tu r bu l e n t  
F l ow I n t e r f a c e s

The Rotating Machinery, Reacting Flow, Laminar Flow Interface

The Laminar Flow version of the Rotating Machinery, Reacting Flow interface ( ) is 
used to simulate the laminar flow and transport of chemical species in equipment 
containing one or more rotating parts. Reactions between the participating species can 
also be studied.

The physics interface combines the functionality of the Rotating Machinery, Laminar 

Flow and the Transport of Concentrated Species interfaces. The Reacting Flow 
multiphysics coupling, which is added automatically, couples fluid flow and mass 
transport. The instantaneous velocity and pressure fields are solved together with an 
arbitrary number of mass fractions. The momentum balance is governed by the 
Navier-Stokes equations, and the total mass conservation is governed by the continuity 
equation. For the chemical species, the governing transport equations include 
convection, diffusion and, optionally, migration in an electric field.

There are two study types available for this physics interface. For the Time Dependent 
study type the rotation is achieved by moving mesh functionality, also known as sliding 
mesh. For the Frozen Rotor study type (see Frozen Rotor in the CFD Module User’s 
Guide), the rotating parts are kept frozen in position, and the rotation is accounted 
for by the inclusion of centrifugal and Coriolis forces. 

When adding the multiphysics interface, the Laminar Flow and Transport of 

Concentrated Species interfaces are added to the Model Builder. A Moving Mesh interface 
with a Rotating Domain node is added automatically in the Model Builder under the 
Definitions node. In addition, the Multiphysics node is added, which automatically 
includes the multiphysics coupling feature Reacting Flow. The following default nodes 
are also added in the Model Builder under Laminar Flow — Fluid Properties, Wall, and 
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Initial Values; and under Transport of Concentrated Species — Transport Properties, No 

Flux, and Initial Values. 

The Rotating Machinery, Reacting Flow, Turbulent Flow, k-ε 
Interface

The Turbulent Flow, k-ε version of the Rotating Machinery, Reacting Flow interface ( ), 
found under the Rotating Machinery, Reacting Flow>Turbulent Flow branch ( )when 
adding a physics interface, is used to simulate the turbulent flow and mixing of 
chemical species in equipment containing one or more rotating parts. Reactions 
between the participating species can also be studied.

This physics interface combines the functionality of the Rotating Machinery, Turbulent 

Flow, k-e and the Transport of Concentrated Species interfaces. The Reacting Flow 
multiphysics coupling, which is added automatically, couples fluid flow and mass 
transport. The averaged velocity and pressure fields are solved together with an 
arbitrary number of averaged mass fractions. The momentum balance is governed by 

In previous versions of COMSOL Multiphysics (prior to version 5.4), a 
specific physics interface called Rotating Machinery, Reacting Flow (rmrf) 

was added to the Model Builder. Now, a predefined multiphysics coupling 
approach is used, improving the flexibility and design options for your 
modeling. For specific details, see The Multiphysics Branch and 
Multiphysics Modeling Approaches in the COMSOL Multiphysics 
Reference Manual.

• The Rotating Machinery, Fluid Flow Interfaces

• Moving Mesh

• Theory for the Free Surface Features

In the CFD Module User’s Guide:

• The Reacting Flow Multiphysics Interfaces

• The Transport of Concentrated Species Interface

• Theory for the Rotating Machinery Interfaces

• Theory for the Reacting Flow Interfaces

• Theory for the Transport of Concentrated Species Interface
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the averaged Navier-Stokes equations, and the total mass conservation is governed by 
the continuity equation. The fluid-flow turbulence is modeled using the standard 
two-equation k-ε model with realizability constraints. For the chemical species, the 
governing transport equations include convection, diffusion and, optionally, migration 
in an electric field. Flow close to solid walls is modeled using wall functions for the flow 
and species transport. Turbulent reactions are modeled using the eddy dissipation 
model.

There are two study types available for this physics interface. For the Time Dependent 
study type the rotation is achieved by moving mesh functionality, also known as sliding 
mesh. For the Frozen Rotor study type the rotating parts are kept frozen in position, 
and the rotation is accounted for by the inclusion of centrifugal and Coriolis forces.

When adding the multiphysics interface, the Turbulent Flow, k-ε and Transport of 

Concentrated Species interfaces are added to the Model Builder. A Moving Mesh interface 
with a Rotating Domain node is added automatically in the Model Builder under the 
Definitions node. In addition, the Multiphysics node is added, which automatically 
includes the multiphysics coupling feature Reacting Flow. The following default nodes 
are also added in the Model Builder under Turbulent Flow, k-ε — Fluid Properties, Wall, 
and Initial Values; and under Transport of Concentrated Species — Transport Properties, 
No Flux, and Initial Values.

See The Rotating Machinery, Reacting Flow, Laminar Flow Interface for details.

The Rotating Machinery, Reacting Flow, Turbulent Flow, k-ω 
Interface

The Turbulent Flow k-ω version of the Rotating Machinery, Reacting Flow interface ( ), 
found under the Rotating Machinery, Reacting Flow>Turbulent Flow branch ( ) when 
adding a physics interface, is used to simulate the turbulent flow and mixing of 

In previous versions of COMSOL Multiphysics (prior to version 5.4), a 
specific physics interface called Rotating Machinery, Reacting Flow (rmrf) 

was added to the Model Builder. Now, a predefined multiphysics coupling 
approach is used, improving the flexibility and design options for your 
modeling. For specific details, see The Multiphysics Branch and 
Multiphysics Modeling Approaches in the COMSOL Multiphysics 
Reference Manual.
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chemical species in equipment containing one or more rotating parts. Reactions 
between the participating species can also be studied.

The physics interface combines the functionality of the Rotating Machinery, Turbulent 

Flow k-w and the Transport of Concentrated Species interfaces. The Reacting Flow 
multiphysics coupling, which is added automatically, couples fluid flow and mass 
transport. The averaged velocity and pressure fields are solved together with an 
arbitrary number of averaged mass fractions. The momentum balance is governed by 
the averaged Navier-Stokes equations, and the total mass conservation is governed by 
the continuity equation. The fluid-flow turbulence is modeled using the Wilcox 
revised k-ω model with realizability constraints. The k-ω model is a so-called 
low-Reynolds number model, which means that it can resolve the velocity, pressure 
and mass fractions all the way down to the wall. For the chemical species, the 
governing transport equations include convection, diffusion and, optionally, migration 
in an electric field. Turbulent reactions are modeled using the eddy dissipation model. 

There are two study types available for this physics interface. For the Time Dependent 
study type the rotation is achieved by moving mesh functionality, also known as sliding 
mesh. For the Frozen Rotor study type the rotating parts are kept frozen in position, 
and the rotation is accounted for by the inclusion of centrifugal and Coriolis forces.

When adding the multiphysics interface, the Turbulent Flow, k-ω and Transport of 

Concentrated Species interfaces are added to the Model Builder. A Moving Mesh interface 
with a Rotating Domain node is added automatically in the Model Builder under the 
Definitions node. In addition, the Multiphysics node is added, which automatically 
includes the multiphysics coupling feature Reacting Flow. The following default nodes 
are also added in the Model Builder under Turbulent Flow, k-ω — Fluid Properties, Wall, 
and Initial Values; and under Transport of Concentrated Species — Transport Properties, 
No Flux, and Initial Values.

See The Rotating Machinery, Reacting Flow, Laminar Flow Interface for details.

In previous versions of COMSOL Multiphysics (prior to version 5.4), a 
specific physics interface called Rotating Machinery, Reacting Flow (rmrf) 

was added to the Model Builder. Now, a predefined multiphysics coupling 
approach is used, improving the flexibility and design options for your 
modeling. For specific details, see The Multiphysics Branch and 
Multiphysics Modeling Approaches in the COMSOL Multiphysics 
Reference Manual.
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The Rotating Machinery, Reacting Flow, Turbulent Flow, SST 
Interface 

The Turbulent Flow, SST version of the Rotating Machinery, Reacting Flow interface ( ), 
found under the Rotating Machinery, Reacting Flow>Turbulent Flow branch ( ) when 
adding a physics interface, is used to simulate the turbulent flow and mixing of 
chemical species in equipment containing one or more rotating parts. Reactions 
between the participating species can also be studied.

The physics interface combines the functionality of the Rotating Machinery, Turbulent 

Flow, SST and the Transport of Concentrated Species interface. The Reacting Flow 
multiphysics coupling, which is added automatically, couples fluid flow and mass 
transport. The averaged velocity and pressure fields are solved together with an 
arbitrary number of averaged mass fractions. The momentum balance is governed by 
the averaged Navier-Stokes equations, and the total mass conservation is governed by 
the continuity equation. The fluid-flow turbulence is modeled using the SST 
two-equation model with realizability constraints. The SST model is a so-called 
low-Reynolds number model, which means that it can resolve the velocity, pressure 
and mass fractions all the way down to the wall. For this reason the physics interface 
can be used to study mass transfer at high Schmidt numbers. The SST model depends 
on the distance to the closest wall, and the physics interface therefore includes a wall 
distance equation. For the chemical species, the governing transport equations include 
convection, diffusion and, optionally, migration in an electric field. Turbulent reactions 
are modeled using the eddy dissipation model.

There are two study types available for this physics interface. For the Time Dependent 

with Initialization study type the rotation is achieved by moving mesh functionality, also 
known as sliding mesh. For the Frozen Rotor with Initialization study type the rotating 
parts are kept frozen in position, and the rotation is accounted for by the inclusion of 
centrifugal and Coriolis forces. In both study types initialization is performed by first 
solving for the distance to the closest wall.

When adding the multiphysics interface, the Turbulent Flow, SST and Transport of 

Concentrated Species interfaces are added to the Model Builder. A Moving Mesh interface 
with a Rotating Domain node is added automatically in the Model Builder under the 
Definitions node. In addition, the Multiphysics node is added, which automatically 
includes the multiphysics coupling feature Reacting Flow. The following default nodes 
are also added in the Model Builder under Turbulent Flow, SST — Fluid Properties, Wall, 
and Initial Values; and under Transport of Concentrated Species — Transport Properties, 
No Flux, and Initial Values.
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See The Rotating Machinery, Reacting Flow, Laminar Flow Interface for details.

The Rotating Machinery, Reacting Flow, Turbulent Flow, Low Re k-ε 
Interface 

The Turbulent Flow, Low Re k-ε version of the Rotating Machinery, Reacting Flow 

interface ( ), found under the Rotating Machinery, Reacting 

Flow>Turbulent Flow branch ( ) when adding a physics interface, is used to simulate 
the turbulent flow and mixing of chemical species in equipment containing one or 
more rotating parts. Reactions between the participating species can also be studied.

The physics interface combines the functionality of the Rotating Machinery, Turbulent 

Flow, Low Re k-e and the Transport of Concentrated Species interfaces. It solves for the 
averaged velocity and pressure fields, together with an arbitrary number of averaged 
mass fractions. The momentum balance is governed by the averaged Navier-Stokes 
equations, and the total mass conservation is governed by the continuity equation. The 
fluid-flow turbulence is modeled using the AKN low-Reynolds number k-ε model. 
The low-Reynolds number model can resolve the velocity, pressure and mass fractions 
all the way down to the wall. For this reason the physics interface is suited for studying 
mass transfer at high Schmidt numbers. The AKN model depends on the distance to 
the closest wall, and the physics interface therefore includes a wall distance equation. 
For the chemical species, the governing transport equations include convection, 
diffusion and, optionally, migration in an electric field. Turbulent reactions are 
modeled using the eddy dissipation model.

There are two study types available for this physics interface. For the Time Dependent 

with Initialization study type the rotation is achieved by moving mesh functionality, also 
known as sliding mesh. For the Frozen Rotor with Initialization study type the rotating 
parts are kept frozen in position, and the rotation is accounted for by the inclusion of 
centrifugal and Coriolis forces. In both study types initialization is performed by first 
solving for the distance to the closest wall.

In previous versions of COMSOL Multiphysics (prior to version 5.4), a 
specific physics interface called Rotating Machinery, Reacting Flow (rmrf) 

was added to the Model Builder. Now, a predefined multiphysics coupling 
approach is used, improving the flexibility and design options for your 
modeling. For specific details, see The Multiphysics Branch and 
Multiphysics Modeling Approaches in the COMSOL Multiphysics 
Reference Manual.
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When adding the multiphysics interface, the Turbulent Flow, Low Re k-ε and Transport 

of Concentrated Species interfaces are added to the Model Builder. A Moving Mesh 

interface with a Rotating Domain node is added automatically in the Model Builder under 
the Definitions node. In addition, the Multiphysics node is added, which automatically 
includes the multiphysics coupling feature Reacting Flow. The following default nodes 
are also added in the Model Builder under Turbulent Flow, Low Re k-ε — Fluid Properties, 
Wall, and Initial Values; and under Transport of Concentrated Species — Transport 

Properties, No Flux, and Initial Values.

See The Rotating Machinery, Reacting Flow, Laminar Flow Interface for details.

Domain, Boundary, Point, and Pair Nodes for the Rotating 
Machinery, Reacting Flow Interfaces

Physics nodes are available from the Physics ribbon toolbar (Windows users), Physics 
context menu (Mac or Linux users), or right-click to access the context menu (all 
users).

L A M I N A R  F L O W

The available physics features for The Rotating Machinery, Laminar Flow Interface are 
listed in the section Domain, Boundary, Point, and Pair Nodes for the Rotating 
Machinery Interfaces.

In previous versions of COMSOL Multiphysics (prior to version 5.4), a 
specific physics interface called Rotating Machinery, Reacting Flow (rmrf) 

was added to the Model Builder. Now, a predefined multiphysics coupling 
approach is used, improving the flexibility and design options for your 
modeling. For specific details, see The Multiphysics Branch and 
Multiphysics Modeling Approaches in the COMSOL Multiphysics 
Reference Manual.

In general, to add a node, go to the Physics toolbar, no matter what 
operating system you are using. 
R  8 :  R O T A T I N G  M A C H I N E R Y ,  R E A C T I N G F L O W I N T E R F A C E S



T H
T U R B U L E N T  F L O W ,  k-ε
The available physics features for The Rotating Machinery, Turbulent Flow, k-ε 
Interface are listed in the section Domain, Boundary, Point, and Pair Nodes for the 
Rotating Machinery Interfaces.

T U R B U L E N T  F L O W ,  k-ω
The available physics features for The Rotating Machinery, Turbulent Flow, k-ω 
Interface are listed in the section Domain, Boundary, Point, and Pair Nodes for the 
Rotating Machinery Interfaces.

T U R B U L E N T  F L O W ,  S S T

The available physics features for The Rotating Machinery, Turbulent Flow, SST 
Interface interface are listed in the section Domain, Boundary, Point, and Pair Nodes 
for the Rotating Machinery Interfaces.

T U R B U L E N T  F L O W ,  L O W  R E  k-ε
The available physics features for The Rotating Machinery, Turbulent Flow, Low Re 
k-ε Interface are listed in the section Domain, Boundary, Point, and Pair Nodes for the 
Rotating Machinery Interfaces.

T R A N S P O R T  O F  C O N C E N T R A T E D  S P E C I E S

The available physics features for The Transport of Concentrated Species Interface are 
listed in the section Domain, Boundary, and Pair Nodes for the Transport of 
Concentrated Species Interface in the CFD Module User’s Guide.
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